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Introduction
What’s in this Manual
This manual provides a menu-by-menu, screen-by-screen listing of
controls and settings available with FlexColor.
Topics include:
• Summaries of all menu commands
• Description of the 3f ﬁle format
• Information about rotating and mirroring images
• Image management from the Thumbnails window
• Full details of all tab sheets in the Setup window
• Full details of the Preferences window
• Instructions for editing ColorSyncTM proﬁles
• Brightness and contrast control with the Gradations window
• Advanced highlight and shadow settings with the Histogram window,
including color neutralization and control
• Advanced color control with the Color Correction window
• Sharpening images and removal of dust & scratches with the Texture
window
• Batch scanning to create individual image ﬁles from each of several
crop and settings combinations

Software compatibility
The FlexColor software works with the entire range of Flextight scanners
(except for the Flextight 4800) and all Hasselblad/Imacon cameras and
camera backs.
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FlexColor under Mac OS and Windows
The CD that came with your scanner includes versions of FlexColor for
both Macintosh and Windows-based systems. The interface is nearly
identical on both platforms, with mostly superﬁcial diﬀerences to
conform with the interface guidelines of the two systems.
Nearly all of the screen captures shown in this manual were taken from
Mac OS X. Windows users will notice the following diﬀerences:
• In the Setup window, the color management tab is called ICM instead
of ColorSyncTM.
• The menus are located at the top of the main FlexColor window instead
of at the top of the screen.

System Requirements
IBM PC-Compatibles
• Minimum recommended Pentium III processor or better.
• 2000 or XP.
• System RAM 512 MB or more recommended.
• Screen resolution of 800 x 600 pixels with true colors (24 bits).
• Mouse or other pointing device.
• FireWire interface or SCSI Interface.
• Minimum available hard disk space of 10 GB
Macintosh
• Recommended G4 or better
• Mac OS X version 10.2.1 or later.
• System RAM 512 MB or more recommended.
• Screen resolution of 800 x 600 pixels with true colors (24 bits).
• FireWire interface or SCSI interface.
• Minimum available hard disk space of 10 GB.
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OS X Requirements
OS X V 10.2.1 or later is required. We recommend updating to the latest
release available.
Devices can be connected by either SCSI or FireWire. Please note that if
you are connecting a SCSI device through a SCSI to FireWire device it
will be represented as a FireWire device – that is the bus number in the
device window will be 9.
To be recognized by OS X, devices connected to a standard SCSI adapter
must be present when booting the Mac. A SCSI device connected via a
SCSI to FireWire adapter will be recognized when the adapter is plugged
in. The SCSI device itself must be turned on before connecting the
adapter to FireWire or rebooting. In OS X the required memory for the
application is automatically allocated.
Support for non-admin users
User deﬁned settings, batch presets and various calibration ﬁles are
located in <user home>/Library/Application Support/FlexColor where
write support is guaranteed. The standard settings are now located inside
the application bundle - therefore you are free to move the FlexColor
application to any location without losing access to these standard
settings.
Preferences ﬁle
FlexColor uses the OS X standard format for preference ﬁles.
The ﬁle name is dk.Hasselblad.FlexColor.plist.
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The 3f File Format
When using the Scan 3f function (for scanners) or capturing an image
with a digital camera back, FlexColor stores the image in Hasselblad’s
unique 3f (ﬂexible ﬁle format).
The 3f ﬁle is an extended TIFF-ﬁle containing
• Raw 16-bit image data
• A complete history of applied settings
• High quality preview image
• Meta-data (including IPTC tags) to support an image database.
In short this means that when you have scanned or captured your image,
you can crop, resize and color correct an unlimited number of times
afterwards. You can easily integrate to databases, have fast previews in
a number of applications and always be able to re-create the quality you
need - all this from the same 3f ﬁle.
Image Archiving & Availability
Because a 3f ﬁle preserves all of the details captured by your scanner or
camera, it is perfect for archiving. Then, for each new job, you will work
with the 3f image in FlexColor and export it to create a new TIFF ﬁle in
which your settings are applied - the only change made to the 3f ﬁle will
be the addition of a new history record of the settings you used.
By making the 3f ﬁles available over your network, you will enable
operators at any workstation to open an image in FlexColor and apply
cropping, correction and conversion just as though they were working
directly on the scanner or camera.
Editing 3f Files
FlexColor holds all tools required for making standard image correction
of the 3f ﬁles.
If you need to apply pixel-editing to your image, FlexColor has a special
plug-in for Photoshop. When installing FlexColor, this plug-in will
be installed in the appropriate plug-in folder if Photoshop is already
installed. Please note that you will permanently alter your original
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scanning or capture data when you save using the plug-in. To use your
3f ﬁles in other image-editing and DTP applications, you must apply the
required settings and then save them as TIFF ﬁles. TIFF is a standard
format that is supported by the vast majority of imaging and DTP
programs.
IPTC Tags
The International Press Telecommunications Council (IPTC) deﬁnes a
standard used in the press industry for exchanging meta-information
in news content, including images. The standard associates an object
with its description within the same ﬁle. You can embed all kinds of
information in your images, such as a caption, the place you took it, the
date and even keywords and categories etc. In FlexColor you are able to
apply a number of IPTC-tags to your 3f ﬁles. See “The Info Window” on
page 79 for details.
Many aspects of managing your images are made easier using the IPTC
standard. Many software programs already exist for doing this, including
Adobe Photoshop. It’s the standard used by professional news agencies
worldwide, and it’s just as useful for others.
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FlexColor Menus
FlexColor commands are available via a standard menu bar. Each of
them is described brieﬂy below. Note that most menu entries also list
a keyboard shortcut to the right of the entry. Try to remember and use
these shortcuts to speed up your work.

The FlexColor Menu
Except for the Preferences entry the FlexColor menu functions are
standard for all applications.

• Preferences: Opens the Preferences window, which enables you to select
an application for viewing ﬁnal scans, make power-saving settings, and
typing some default information for the 3f ﬁles.
See “The Preferences Window” on page 53 for more information.
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The File Menu

The File menu includes entries that initiate scans and make settings for
FlexColor.
• Scan Preview: Takes a low-resolution preview scan. The preview
image will be displayed in the main FlexColor window so that you can
preview settings and crop the image for the ﬁnal scan. All settings are
previewed using the full 14-bit color depth to display results.
• Scan 3f: Scans the image and saves it as a 3f ﬁle. The various settings
for the ﬁle such as cropping, resolution and IPTC info are set in the
window that pops up when selecting the function. See page 118 for
details.
• Final Scan/Save: The Final Scan entry takes a ﬁnal-resolution scan
from the preview scan and saves it as a TIFF-ﬁle on your hard disk.
When having scanned the image as a 3f ﬁle (see page 10 for details) the
entry changes to Save, which saves the image currently shown in the
FlexColor window as a standard TIFF ﬁle. In both cases all current
crop, mode, color and image-enhancement settings will be applied to
the saved image.
• Close: Closes the currently selected window if possible.
• Setup: Opens the Setup window, in which most of the basic settings
for a scan can be made, saved and loaded. See “The Setup Window” on
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page 35 for more information.
• Devices: Opens the Devices window. The window lists all connected
devices allowing you to select which camera or scanner device you want
to work with. Click on the one you prefer and click the Select button.
If you have only a single scanner or camera connected this device is
automatically chosen. The numbers just to the right of the scanner or
camera icon in the list (ex. 0-5) refers to the Bus no. (0) and the SCSI
address (5).
• Get Info: Opens an Info window, which contains various information
about the currently selected image. See “The Info Window” on page 79
for a detailed description.
• Page Setup.../Print… : Enables you to print the contents of the
Thumbnails window. Make sure you have selected the view by clicking
on a thumbnail in the window, then select Print.
• Move to trash: Moves the currently displayed image to trash can. If
you are in the Thumbnail window the selected images will be moved
to trash

The Edit Menu
The Edit menu contains entries that enable you to undo multiple actions
that you have made while making settings in FlexColor. It also enables
you to cut, copy and paste text in various windows.

16
• Undo: Reverses your most-recent actions - for example, a crop area
modiﬁcation or a change in the Setup window. You are able to step back
through a long series of actions.
• Redo: Reapplies the last action that you cancelled using the Undo
command.
• Cut: If you have selected some text in a text ﬁeld, then this command
removes the text and saves it on a system-wide virtual clipboard.
• Copy: Saves the selected text on the clipboard without removing it.
• Paste: Places a copy of the text on the clipboard at the insertion point.
• Clear: Removes all text from the clipboard.
• Select All: Selects all of the text contained in the ﬁeld in which the
insertion point is standing. In the Thumbnails window, this selects all
of the icons in the window (see “The Thumbnails Window” on page 65).
• Deselect: Removes the cropping of the currently shown image.
• Show Clipboard: displays the current contents of the clipboard.

The Image Menu

The Image menu gives you quick short cuts to functions that are also
available from within the modify dialog in the Thumbnails window (see
page 65 for details). You have the possibility to select a number of ﬁles
and choose Modify from the Image menu. This will add a corresponding
number of processing tasks to the list in the Task window and processing
of those ﬁles will take place in the background. Processing tasks will not
be interrupted by new scanning processes.
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Modify
When using the Modify... function to add settings from current settings
the cropping will be maintained in the added settings. If the images in
question have diﬀerent sizes the cropping will be scaled accordingly.
Approve
Select a number of images and chose Approve. These images will
appear in the top at the Thumbnail window if you have selected sort by
approval.

The View Menu

The View menu exposes some of the “secret” short cuts that relate to the
control of grid, overlay and crop mask and to zooming and selection of
images.
The Soft Proof feature combines the ICC color proﬁle of your monitor
with the proﬁles of your camera back and output device to provide a
simulation of the output colors on your screen. Enable this only when you
are sure about the speciﬁc output device you are using. If you are making
a general-purpose RGB capture, then keep this feature unselected.
A small s to the right of the Color Info area in the main FlexColor
window indicates that Soft Proof is enabled.
The Hide Tools item lets you hide all tool windows.
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The Maintenance Menu
The Maintenance menu includes entries that are used for calibrating and
upgrading the scanner. The functions of these entries will depend on the
model of Flextight scanner you are using.
• Focus Calibration: Opens the Calibration window, which calibrates
the focus and sizing of the scanner. See your scanners hardware
documentation for details of when and how to perform this calibration.



This function does not apply to the Flextight Photo and 343 scanners.
• White Calibration: Initiates a white calibration scan for reﬂective
originals.
See your scanners hardware documentation for details of when and how
to perform this calibration.



Only scanners that support reﬂective scanning require this function.
• Feeder: Opens the Feeder window, which allowe Mounting and Unmounting of Feeders, as well as adjusting and trouble shooting . See the
Feeder documentation for further details.

The Window Menu
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The Window menu opens and closes each of the image settings window
available with FlexColor. Each window that is currently open shows a
check mark to the left of its name. For more information about each of
these windows, see the appropriate section later in this manual:
Gradations window. . . . . . . . . . see page 93.
Histogram window . . . . . . . . . . see page 85.
Color Correction window. . . . . see page 99.
Texture window . . . . . . . . . . . . . see page 101.
Detail window . . . . . . . . . . . . . see page 107.
Batch Scan window . . . . . . . . . see page 109.
Thumbnails window. . . . . . . . . see page 65.
Color Info window . . . . . . . . . . see page 83.



The Exposure, Live Video and import entries are not available when you use
FlexColor with a Flextight scanner.
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The Main FlexColor Window
Introduction
The main FlexColor window displays your preview images and provides
access to most of the scanning and editing functions available with
FlexColor.

Scan Controls
Preview Makes a preview scan. A preview image will appear in the
large area on the right. All image correction settings (such
as tonal range, gradation and color corrections) will also be
previewed on this image.
Scan...

(This button changes to a Save button when working with a
3f ﬁle in the preview window). Makes a ﬁnal scan (saved as a
standard TIFF ﬁle) from the preview image using the current
crop, mode, color and image-enhancement settings.
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Save...

(This button changes to a Scan... button when working with
a preview scan in the preview window). Saves an image (as a
standard TIFF ﬁle) from the 3f ﬁle currently displayed in the
FlexColor window. All current crop, mode, color and imageenhancement settings will be applied to the saved image. A
history record of the settings used when saving the ﬁle, will be
added to the History list in the 3f ﬁle’s Info window. See “The
Info Window” on page 79 for details.
3f... Scans the entire area of the selected frame or the current
cropping of the preview image and saves it as a 3f ﬁle in the
currently selected folder. The image will be displayed in the
FlexColor preview window. Please note that the 3f ﬁle will
be scanned using the cropping, resolution and IPTC settings
as speciﬁed in the window that pops up when selecting the
function and on the 3f tab in the Preferences window (see
page 55). See “The 3f File Format” on page 10 earlier in this
manual for details.
Previous/Next Image Buttons: Use these buttons to select
previous or next image from the thumbnails folder.
Batch Scan Button: Opens the Batch Scan window, from
where you can perform a batch scan, which can be either
several scans from the same preview using diﬀerent crops and
settings or when scanning from the Feeder units (Flextight
848 and 949 only). See “Batch Scanning” on page 109 for more
information.
Thumbnails Button: Opens the Thumbnails window, which
holds thumbnail images of all of the 3f ﬁles aved in the current
folder. See “The Thumbnails Window” on page 65 for more
information.
Setup Use this pop-up menu to choose between any of the
currently available setups. A small + will appear to the right of
the menu to indicate when you have made custom changes that
aﬀect the setup but have not been saved.
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Frame Use this pop-up menu to set the ﬁlm format (size) of
the original you are scanning. This setting mirrors the Frame
setting on the General tab of the Setup window. See “General
Tab” on page 38 for more information.
Selecting the Customize... entry from the list enables the
creation of your own custom frames. See “Custom Frames” on
page 31 for details.
Auto Frame Button: Toggles the Automatic Frame. When the
function is enabled the scanner will automatically read the
current original holder’s identiﬁcation code (a combination of
small rectangular holes at the holder’s leading edge) and adjust
the Frame settings accordingly.
The button reﬂects the setting of the Automatic Frame
Recognition check box on the Scanner tab of the Preferences
window. See “Preferences” on page 53 for details.


Mode

The button is only available for scanners supporting the
Automatic Frame Recognition function!
Use this pop-up menu to set the scan mode (RGB, RGB 16 bit,
Grayscale, Grayscale 16 bit, Lineart, or CMYK). This setting
mirrors the Mode setting on the General tab of the Setup
window. See “General Tab” on page 38 for more information.

Keyboard Shortcuts
See “Appendix” on page 124 for related keyboard shortcuts.

Auto Focus Controls
Only available if your scanner supports the Auto Focus function!
Auto focus: This check box toggles the Auto Focus function
on/oﬀ. Before the ﬁnal scan the scanner performs a quick
focusing in a horizontal line in the center of the current
cropping area.
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Auto Focus Indicator: Shows the current focusing level
(indicated by a red or green horizontal line) compared to
the standard focus calibration, which is represented by the
horizontal line in the center of the indicator.
Please note that a red line indicates a coarse deviation, and in this case
it is recommended to perform a focus calibration. See your scanner’s
“User’s Guide” for references.

Color Display

To use the Color Display, place the mouse cursor over the preview image.
The number ﬁelds in this area indicate the pixel value at the selected
position in the image.
Note the following:
• The values indicate values after gradation and tonal range settings.
• When showing CMYK, the values indicate ink percentage values (0
- 100) with white = 0, 0, 0, 0.
• When showing RGB, the values indicate pixel brightness values (0 255) with white = 255, 255, 255.
Color Info button: Opens/closes the Color Info window. This
window is also available from the Window menu. See detailed
description in “The Color Info Window” on page 85.

Corrections Controls
Histogram Button: Opens/closes the Histogram
window. See “The Histogram Window” on page 85 for more
information.
Gradation Button: Opens/closes the Gradations window.
See “The Gradations Window” on page 93 for more
information.
Color Correction Button: Opens/closes the Color Correction
window. See “Selective Color Correction” on page 99 for more
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information.
Texture Button: Opens/closes the Texture window. See “The
Texture Window” on page 101 for more information.
Click this button to apply automatic settings for highlight and
shadow points based on the histogram of your image inside
the cropped area.
Click on this button to return all correction windows
(Gradations, Histogram, Color Correction, and Unsharp
Mask) to their neutral settings.

Output Size Controls
Width

Height

Zoom

PPI

Size

The measured width of the output image. The units used are
set in the Preferences window. See “The Preferences Window”
on page 53 for more information.
The measured height of the output image. The units used are
set in the Preferences window. See “The Preferences Window”
on page 53 for more information.
The level of magniﬁcation applied when the image is saved,
either by making a ﬁnal scan or when saving from a 3f ﬁle. The
Width and Height settings will update to reﬂect the setting
you make here. Note that if you choose a setting other than
100%, then FlexColor will interpolate the image to ﬁt the size
you specify.
The output resolution of the ﬁnal image. The Width and
Height settings will update to reﬂect the setting you make
here. When making a ﬁnal scan, please note that those settings
that, combined with the current Zoom setting, will result in
a non-interpolated (true optical resolution) scan, are shown
underlined in the PPI pop-up menu.
The ﬁle size of the ﬁnal image ﬁle. This is aﬀected by the
Width, Height, Zoom and PPI settings. It is possible to type
a desired output ﬁle size. This will adjust the zoom percentage
correspondingly (max. 200%).
Lock button: The lock button enables you to lock the output
width and height settings. When the lock is closed, then the
output width and height will not change when you modify the
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crop area by dragging one of its corners, and the proportion of
height to width will be maintained. Click on the lock to toggle
its setting.
Crop Button: Usually this button is gray, which indicates
that the crop tool is active. When the crop tool is active, you
are able to click and drag on the preview image to create and
manipulate the crop area. However, some tools, such as the
color pickers, change the cursor so that it selects colors instead
of deﬁning a crop area. When one of these tools is active, the
crop button is white. To return to the crop tool, click on the
crop button.
Note the following points about working with the crop and size tools:
• When you work with a scanner, you will typically know the target
output dimensions and resolution. If so, ﬁrst enter the dimensions in
the Height and Width ﬁelds and choose the output resolution from the
PPI pop-up menu. Then click on the lock icon so that it is closed (this
will lock your height and width settings). You are now able to click and
drag the crop area to deﬁne the composition of your image - the Zoom
value automatically tracks your changes without changing the height,
width, or PPI of your output image.
• To set the crop area, place the mouse cursor over the preview image.
Click and hold over one corner of the area you wish to scan and drag
the cursor away to outline the area. Release the mouse button to select
the area.
• To move the crop area, place the mouse cursor inside the outline, then
click and drag the area. Release the button to drop the area again.
• To resize the crop area, place the mouse cursor over one of the sides or
corners. The cursor will change into a double sided arrow. Click and
drag the side or corner to stretch or shrink the area.

Zoom Controls
Zoom out: Click this button to make the preview image
smaller.
Zoom in: Click this button to make the preview image larger.
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Fit to Window: Click this button to resize the preview to ﬁt
the actual window size.
Detail: Click this button to open the Detail window. Use
this window to show details of the image and/or a strongly
magniﬁed view of the preview image for reading color values
of a speciﬁc pixel in your image. See “The Detail Window” on
page 107 for more information.
Current zoom level
Keyboard shortcuts for zooming
• To ﬁt the entire preview image in the window, type cmd-0.
• To zoom in, type cmd +.
• To zoom out, type cmd -.
• To zoom to 100%, type alt-cmd-0.
• To open the Detail window, type cmd-5.

Orientation Controls
Mirror Button: Mirrors both the preview and ﬁnal image.
Rotate Buttons: Rotates both the preview and ﬁnal image 90°
steps in either direction. See “Rotating Images on page 28 for
more information.

Orientation Icon: Shows the current rotation/mirroring in
relation to your scanned original.
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Rotating Images
In some cases, your originals may be rotated so that they
appear sideways in relation to the FlexColor preview window.
You can use the rotate buttons to rotate the image 90° either
clockwise or counter clockwise. Both the preview and the ﬁnal
image will be rotated.
Mirror
Note that scanning rotated images will require more memory and will
slow down your scans slightly - especially for large scans.

Other Controls
Grid/Overlay button: Adds a grid or an overlay over the
preview, which can be useful for lining up your original before
the ﬁnal scan.
Holding down the option key while clicking the button opens
the Grid options window:

Here you are able to deﬁne the number and color of the lines
in the grid. The number of lines is per the smallest image
dimension (width or height). If the Use overlay checkbox is
checked, the speciﬁed overlay will be displayed instead of
the grid. To return to normal grid mode simply uncheck the
checkbox. See page 29 for details about adding an overlay to
the image.

29
Overlay: This function is primarily for digital camera back
users. It is possible to add an overlay to the preview. All the
standard image ﬁle types such as TIFF, JPEG, GIF, and PNG
can be used. To place the overlay simply drag the image ﬁle
into the preview window. Once in place you can click and drag
the overlay image around to align it correctly. Since the over
lay replaces the grid, it is turned on and oﬀ using the Grid/
Overlay button (see page 28).
Crop mask: Darkens the disregarded part of the image to help
evaluate the crop.
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Custom Frames
Flextight ships with a selection of original holders that support
several standard formats of originals. It is also possible to use custom,
nonstandard formats with Flextight. A larger number of custom frame
formats can be deﬁned.
To deﬁne a Custom frame do the following:
• Select Customize... from the Frame pop-up menu in the main
FlexColor window. The Frames window appears.

The window shows a list of frames relevant to your current scanner. A
check mark indicates whether or not a frame should be available from
the Frame pop-up menu. To add or remove a frame either double-click
it or select it and click the Exclude/Include button. The pre-deﬁned
frames in the list (deﬁned by Hasselblad) are not editable and thus
marked with a non-edit symbol to the left.
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When a frame is selected its current settings are displayed in the Frame
Info section. Click the small triangle to the left to display the settings if
not already displayed.
• Click the New... button. The Create new Custom frame window
appears.



If the Scan holder checkbox is checked when the window appears,
your scanner supports scanning of original holder frames as described
in “Scanning of Original Holder Frames” on page 34. Type a name that
will help you remember the format and click on Create. The new frame
is added to the frame list using the speciﬁcations of the frame currently
selected in the Frame pop-up menu.
• Select the appropriate holder type from the Type pop-up menu and edit
the Width, Height and Vertical Oﬀset values to match your frame.
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If your scanner has a moveable optical system, you are able to specify both
Width, Height and Vertical oﬀset for transmission frames, but reﬂective
frames are still limited to the few ﬁxed widths because of the white
calibration used in reﬂective mode.
• If you want to specify a frame with 2 apertures you can do so by
clicking the Split Frame... button.

• From the Split frames pop-up select how many equally sized apertures
you want to split the frame into and click Create.
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• Now a number of sub-frames, one for each aperture, are added to the
list, and you can edit the Width, Height and Vertical Oﬀset values of
each aperture.
• To delete a custom frame from the list, select it and click the Delete...
button.
• When ﬁnished close the Custom Frames window.
Note! Clicking the Default button will reset the Frames list to the
original list containing the frames shipped with your scanner.
Scanning of Original Holder Frames
NOTE! If your scanner supports it, you are able to simply place the new
holder in the scanner and in the Create new Custom frame window
name the frame, check the Scan holder box and click Create. The
scanner will scan the holder and the obtained values will be displayed in
the Frame Info section. This will make the holder recognizable by the
Automatic Frame Recognition function (see page 54) and enable full use
of the 3f facilities.
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The Setup Window
Introduction
The Setup window shows many settings that aﬀect the image and the
way in which the other tools in the FlexColor application work. All of the
settings displayed in the window can be saved and loaded from your hard
disk.
To open the Setup window, type cmd-U or select Setup from the File
menu.

Many of the settings, such as sharpness, gradation, and color correction,
are available individually through tool buttons in the main FlexColor
window. All settings you make using the individual tools are also applied
to the Setup window, and vice versa.
The Setup window is divided into several tab sheets to help you ﬁnd the
setting you want to make.
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The FlexColor Setup Philosophy
In the traditional prepress environment, where photographs are shot
to ﬁlm and then scanned, the professional scanner operator requires
extensive education and experience to make all of the settings required to
obtain good results. The operator examines each original and, applying
his or her experience, enters a “best guess” of what all the settings should
be for that particular type of original. Then the operator checks the
preview and makes ﬁne tuning adjustments.
FlexColor simpliﬁes this process by enabling you to save a library of
setups that you use most frequently. Nearly all FlexColor settings,
including all settings in the Setup, Gradations, Histogram, and
Unsharp Mask windows, are saved in each setup ﬁle.
Each time you scan a new original, select the closest setup from the Setup
menu, deﬁne the crop, click on the Auto button, and you are 98 to 100%
of the way to a perfect scan.
FlexColor is delivered with several generic setups to get you started
quickly. Use the Setup pop-up menu to choose a setup that is appropriate
for your current job. The name of each setup indicates its intended use.
Start by using the generic setups. If you want to develop your own setup
library, begin with the closest of the available generic setups, modify it,
and save it with a new name.

Managing Setups
To create a new setup, click on the New button. A window will appear in
which you can name the new setup. All of the settings currently applied
in the Setup, Gradations, Histogram, and Texture windows will be
saved in the new ﬁle.
To rename the currently loaded setup, click on the Rename button. A
window will appear in which you can rename the setup.
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After you have made changes to the current setup, save them by clicking
on the Save button in the Setup window.
To delete the current setup, thereby removing it from the Setup pop-up
menus, click on Delete.



The generic setups that ship with FlexColor are locked so that you can not
accidentally modify, rename or delete them. If you want to modify a
generic setup, then select the setup from the Setup pop-up menu, make
modiﬁcations, then click on New to save your new setup with a new name.

Advanced Setup Management
The Setup pop-up menu in the main FlexColor window is organized into
sections. User-deﬁned setups appear at the bottom of the list. All of the
setups are saved as individual ﬁles in a folder called Settings, which is in
the same folder as the FlexColor application. Each section shown in the
Setup pop-up menu corresponds to a folder inside the Settings folder. If
you would like to customize the organization of the menu, then you can
add new folders and/or move setup ﬁles as required.
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General Tab
The General tab of the Setup window aﬀects the general behavior of the
interface and identiﬁes the setup ﬁle currently loaded.

Mode
Provides a pop-up menu for choosing the color space used when making
your ﬁnal scan. The following options are available:
• RGB: stores ﬁnal images as standard 8-bit RGB TIFF ﬁles.
• RGB 16-bit: stores ﬁnal images as 16-bit TIFF ﬁles. This preserves the
full color resolution captured by the scanner, but creates larger ﬁles that
many applications cannot read.
• Grayscale: creates grayscale images, such as black and white
photographs. Grayscale ﬁles are smaller than color ﬁles, so use this
mode if your originals or ﬁnal publications are in black and white. To
obtain a grayscale result, FlexColor combines information from all
three RGB color channels.
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• Grayscale 16-bit: stores ﬁnal images as 16-bit grayscale TIFF ﬁles.
This preserves the full tonal range captured by the scanner, but creates
ﬁles that many applications cannot read. To obtain a grayscale result,
FlexColor combines information from all three RGB color channels.
• Lineart: creates 1-bit images in which each pixel is either 100% black or
100% white. These ﬁles are even smaller than grayscale images. Use this
mode if your originals are, for example, pen and ink drawings. To adjust
the threshold at which the input will jump to either black or white, use
the Gradations window. See “Setting the Threshold for Lineart Scans”
on page 97 for more information. ICC proﬁles have no eﬀect when you
use this mode.
• CMYK: creates print-ready color images. You must set up an ICC
proﬁle to create CMYK images directly from FlexColor. See “ColorSync
or ICM Tab” on page 47 for more information about ICC proﬁles.
Frame
Use this pop-up menu to choose the original holder you will be using for
your scan.
Resolution PPI
Deﬁnes the resolution of the output image. Set this value according to
the requirements for your printed output. Most high-quality color work
uses 300 ppi. Newspapers typically use less (150 to 200 ppi). On-screen
display, such as for the web, requires only 72 ppi. See “Size Controls” on
page 25 for more information about PPI and image sizing.
Zoom
The level of magniﬁcation applied when the image is saved. See “Size
Controls” on page 25 for more information about zooming and image
sizing.
Descreen
If you are scanning an oﬀset-printed original, then this setting will
compensate for rosettes in the original. It attempts to prevent moiré
patterns from appearing in your print, at the expense of defocusing the
image. The higher the setting, the more extreme the eﬀect will be.
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Adaptive Light
If your originals are very dark you can use this setting to increase the
exposure time (older scanner models will increase light intensity).
Film Type
Use this pop-up menu to identify the type of original you are scanning.
The following options are available:
• Positive: for positive color or black and white images.
• Color Negative: for negative color images.
• B/W Negative: for negative black and white images.
Mirror
If your original is a mirror image, or if you want to create a mirrored
image from the original, then place a check in this box. To keep the
image as scanned, make sure this box is not checked.
Optimize
In the Optimize pop-up you have the following options:
• Quality: Use this setting to obtain the highest quality.
• Speed: Enables faster scan times by taking greater advantage of
resizing.
• True Resolution: Use this mode to avoid any kind of software resizing.
Enhanced shadow detail
Activates an algorithm that delivers more details in the shadow areas.
This function is not suitable for images with a very narrow dynamic
range or for images with an unusually high amount of color information
in dark areas.
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Contrast Tab
The settings on the Contrast tab sheet are exactly the same as in the
Gradations window (available from the Window menu). Changes made
here in the Setup window will also change the settings in that window,
and vice versa.
See “The Gradations Window” on page 93 for more information about
these settings.
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Texture Tab
The settings on the Texture tab (except for the Color % setting) reﬂect
those made in the Texture window (available from the Window menu).
For more details about using the Unsharp Mask, Color Noise and
FlexTouch functions, see “The Texture Window” on page 101.

Color %
These three ﬁelds (Red, Green, and Blue) control the amount of
sharpening eﬀect applied in each color channel. Normally, you should
leave them set to 100 each, which applies sharpening equally to all
channels. In some cases, you may be able to reduce the eﬀect of noise by
applying less sharpening to one channel (typically the blue channel). You
can also use these settings to create special eﬀects.

CC (Color Correction) Tab
The CC tab contains a color correction chart, which enables you to alter
the way input colors are mapped onto the output colors. It can be used to
remove or add color cast, or to create stronger colors in your images.
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The matrix contains the same settings as the Color Correction window
(available from the Window menu), and displays all of the settings
you have made using that window. In many cases, it will be easier for
you to make adjustments using the Color Correction window instead.
See “Selective Color Correction” on page 99 for more information.
However, the matrix shown here gives a better overview of all of the color
correction settings for the current setup.
To activate the color correction, mark the Apply check box. To disable
the color correction settings, remove the mark from this box. Click on
the box to toggle the mark.
To modify the amount of any one color component in the image, click on
the button next to the target color along the top of the matrix. Then use
the up and down buttons for each component color along the left side of
the matrix to add or remove that component from the target color.
Alternatively, you can click on any of the ﬁelds in the matrix and edit the
value with your keyboard. To modify the saturation in the entire image,
use the Saturation up and down buttons or input ﬁeld.
To reduce the amount of magenta in blue and add yellow in green, do as
follows:
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A full explanation on all of the applications of this tool would be complex
and beyond the scope of this manual. If you would like to know more
about color mapping, please speak with your printer or consult the
electronic prepress section of your local library or book store.

Auto Tab
The Auto tab sheet has percentage settings for both Shadow and
Highlight. When you use the Auto button, the FlexColor application
computes what it thinks the highlight and/or shadow values should be
based on the histogram of your image. It then modiﬁes the values by the
percentages that you set here to ﬁnd the ﬁnal setting. The percentage is
applied to the diﬀerence between the highlight and shadow settings.

For example, if the Auto % for Highlight is set to 2 and you use the auto
function on an image in which the highlight might normally be 200, then
FlexColor will assign a highlight value of 196 (provided the shadow value
was zero). If you ﬁnd that you frequently need to adjust the highlight or
shadow values to be tighter than the auto function normally chooses,
then use a positive setting here. Positive settings will result in a relative
increase in the contrast.
You are able to set negative values for the Auto % settings. This will
make the automatic controls use less extreme settings for highlight and
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shadow than normal. For example, if the Auto % for Highlight were set
to -2, and you use the auto function on an image in which the highlight
might normally be 200, then FlexColor will assign a highlight value of
204 (provided the shadow value were zero). This setting will enable you
to preserve more details at the extremes of the tonal range than you
otherwise would if the highlight point were set lower.
For more information about working with highlight and shadow points,
see “The Histogram Window” on page 85.

Dot Tab
The settings on the Dot tab aﬀect the output of the image brightnesses.
Normally, the output will be a maximum (255) at the brightest
(highlight) point and minimum (0) at the darkest (shadow) point for
each color. However, this can sometimes cause trouble for the printing
presses, especially when too much ink is applied for the paper to dry
quickly enough.

Printers often request that images be prepared to lie within certain limits.
The settings on this tab sheet limit output at the extremes at each color.
Speak to your printer for advice about how to set these values.
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The values in the three (RGB) columns control the maximum (for
highlight) or minimum (for shadow). For RGB color, 8-bit values (0 to
255) are shown for each color.
The Endpoints pop-up menu determines how the values for the color
columns will be assigned when the input values exceed the deﬁned limits.
They work as follows:

Cut-oﬀ: All values beyond the limit will remain at the
limit.
Round-oﬀ: All values beyond the limit will be spread out
evenly between the limit and the maximum (0 or 255).
Force max: All values beyond the limit will be forced
to the maximum (0 or 255).
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ColorSync or ICM Tab
ICC color proﬁles deﬁne the color response of each device in your
system. FlexColor uses these proﬁles to make calibrated, accurate, and
high-quality color separations from your images.
Under Mac OS, ICC proﬁles are controlled by Apples ColorSync
technology and the setup tab for selecting ICC proﬁles in FlexColor is
called ColorSync TM .
Under Windows 2000 and XP, ICC technology is referred to as “ICM”
(which stands for “Image Color Management”) and the tab for selecting
ICC proﬁles in FlexColor is called ICM.
Flextight scanners and most monitors and output devices include
ICC proﬁles, which will help make sure the colors in your original are
maintained and that colors you see on your screen will be accurately
reproduced on paper.
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For more information about using ICC proﬁles, see the online help
for your operating system. For information about Apples ColorSyncTM
technology, check Apple’s web site at:
http://www.colorsync.apple.com and/or http://www.apple.com.
Input (Mac)
This pop-up menu shows a list of input ICC proﬁles installed on your
system.
When selecting an input proﬁle it is possible to choose a “Device
Default Proﬁle”, enabling you to deﬁne a setting that will always use
the currently selected device proﬁle for the current device. To do this
select the second item in the input proﬁle menu - it will be titled Device:
<proﬁlename>, where <proﬁlename> is the name of the default proﬁle
for the current device.
To change the default proﬁle simply click the Change button located to
the right of the input proﬁle menu. This will lead you to the ColorSync
Utility application.
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Here you simply select the Devices view which gives you a list of
registered devices. After selecting your camera or scanner in the list you
can either assign a new default proﬁle or switch back to factory default.
The new standard settings installed with this release all use the device
default proﬁle (except for settings for scanning negatives, since they
do not use device dependent proﬁles). The primary beneﬁt of this new
feature is that you can now switch to your own custom input proﬁle
without having to edit any of your existing settings.
Input (PC)
Functionality is basically the same as for Mac except that clicking the
Change button will open the Scanners and Cameras control panel which
shows the list of connected devices.
Here you can select properties for your device(s) which will bring up a
dialog box from where (e.g. Color Management tab) you can change the
color management e.g. the list of attached proﬁle(s).
Please note that FlexColor will always choose the ﬁrst proﬁle found in the
list if more than one are present.
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RGB
This pop-up menu lists all of the RGB proﬁles currently installed on your
system. Choose a proﬁle that represents the color space in which you
work. (If you are using Adobe Photoshop, you can choose the space used
by Photoshop). To see which space is used by Photoshop, start Photoshop
and choose Edit -> Color Settings. The Color Settings window appears
(see the Getting Started... manual for more information about using
this window). In this example the RGB working space is the ICC proﬁle
Adobe RGB (1998).

If you choose an RGB color space (ex. Adobe RGB 1998) you should
check both the Convert and Embed Proﬁle ﬁelds on the ColorSync or
ICM Tab.
Click on the Save button and save your selected RGB working space
as an ICC proﬁle. Give the proﬁle a new name and save it in the ICC
proﬁle folder used by your operating system. For most recent versions
of the Mac OS, use the OSX: System/Library/ColorSync/Proﬁles. For
Windows, use WINDOWS\SYSTEM32\SPOOL\Drivers\Color. The
RGB drop down list now shows the name of the ﬁle that you just saved.
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CMYK
This pop-up menu lists all of the output proﬁles currently installed on
your system. Choose the proﬁle speciﬁc for your output device, or select
the closest of the generic proﬁles supplied with FlexColor. See “Generic
ICC Output Proﬁles” on page 59 for more information about the generic
proﬁles.
Edit
The Edit button appears only if you are using the Mac OS version of
FlexColor. Click on this button to edit the output proﬁle. Use this
feature only if you are an advanced user, or on the advice of your printer.
For more information about editing ColorSync proﬁles, see “Editing
ColorSync Color Proﬁles” on page 60.
Gray
FlexColor oﬀers full support even when saving images in grayscale. To
do so simply check the required Embed and Convert options, and if you
have checked Convert you also need to select a grayscale output proﬁle.
Please note that you do not need to select a diﬀerent input proﬁle when
in grayscale mode, as a suitable grayscale input proﬁle is automatically
generated based on the currently selected RGB input proﬁle.
Convert
If this checkbox is marked data will be converted according to the
current settings of input and output proﬁle. Otherwise the output ﬁles
will contain data without any ICC corrections applied.
Softproof
Mark this checkbox to see an on-screen representation of the colors
expected from your output device. It combines the output proﬁle with
the monitor proﬁle selected for your system to create a simulation of the
output colors. See the Getting Started... manual for instructions on how
to set up a monitor proﬁle for you system and for advice about using the
Softproof feature.
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Embed Proﬁle
Mark this checkbox to embed a proﬁle with your saved image. The
embedded proﬁle will always match the content of the ﬁle. If conversion
is active the embedded proﬁle will be the output proﬁle corresponding
to the current scan mode setting - either the RGB or the CMYK proﬁle.
If the convert checkbox is not checked the embedded proﬁle will be the
current input proﬁle.
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The Preferences Window
Introduction
The Preferences window contains several miscellaneous settings that
control the general functions of the scanner and the software. The
Preferences window settings are universal for the FlexColor application,
they are not saved with the other settings in the setup ﬁles. To open the
window, select Preferences from the FlexColor menu.

Scanner Tab

The Scanner tab holds the following settings for your current device:
Power-Saving Features
To save power, you are able to make settings that will cause the scanner
to shut down after a speciﬁed period of inactivity. There are two levels of
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power saving available:
• Power down after: the scanner is turned oﬀ, just as if you had pressed
the on/oﬀ button on the scanners front panel.
• Light oﬀ after: the scanner remains turned on, but the light is shut oﬀ.
Use the sliders to make settings for how long the period of inactivity
should be before activating the relevant power-saving function.
Use External White Calibration
Some older Flextight Precision scanners make use of this option when
checking the white calibration. However, we now recommend that all
Flextight users use external calibration, so this box should always be
checked. On other Flextight models, this box does nothing.
If you are using a Flextight Precision scanner, then see the calibration
information in your original scanner hardware manual for details.
Automatic Frame Recognition
Only available for scanners supporting the function! The check box
toggles the Automatic Frame Recognition function on/oﬀ. When the
function is enabled the scanner will automatically read the current
original holder’s identiﬁcation code (a combination of small rectangular
holes at the holder’s leading edge) and adjust the Frame settings
accordingly. The check box setting reﬂects the setting of the Auto Frame
Button in the main FlexColor Window (see page 23).

Camera Tab
For digital camera backs only!

3f Tab
When you make a scan using the Scan 3f function, the image is saved as
a 3f ﬁle in the currently selected folder. The 3f ﬁle can contain various
information about the ﬁle, as described in “The 3f File Format” on page
10 earlier in this manual.
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Scan Size
Use these settings to set general limitations for your 3f ﬁles. If you set
the value in the Percentage of max. resolution ﬁeld to ex. 50%, all
3f ﬁles will be scanned in half of the max. resolution available for the
currently selected original holder. If the size of the 3f ﬁle exceeds the
size as set in the Maximum 16-bit Size ﬁeld, the scanning resolution will
automatically be reduced to keep the ﬁle size within the set value.
Default Info
Prior to taking a number of scans where you want to add the same
name and copyright information to all of the 3f ﬁles, you can type this
information in the Byline and Copyright ﬁelds. Later when opening the
Info window for one or more of the ﬁles, this information will show up
in the corresponding ﬁelds here. See “The Info Window” on page 79 for
references.
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Output Proﬁles
The Output Proﬁles tab enables you to establish the default ColorSync/
ICC proﬁles used by FlexColor. Though output proﬁle settings are
saved with each setup, one of the options for each of them is to use the
default setup established here. This way, you can make setups in which
the output proﬁle is assigned dynamically according to the program
preferences.

The following settings are provided on the Output Proﬁles tab:
• RGB Default: select a default output proﬁle for saving to RGB.
• CMYK Default: select a default output proﬁle for saving to CMYK
• Gray Default: select a default output proﬁle for saving grayscale
(black & white) images.
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General FlexColor Settings

The bottom of the Preferences window holds the following general
FlexColor settings:
Opening Saved Images
After saving an image as a TIFF ﬁle, FlexColor is able to launch the
application of your choice and open the saved image in that application.
If you would like to use this feature, place a check in the Open saved
images with checkbox, then click the Select... button. Use the appearing
standard ﬁle ﬁnder window to locate and select the application you
would like to use for viewing your saved images.
Auto after New Crop
FlexColor includes an auto tonal range function, which analyzes the
cropped image and sets highlight and shadow values accordingly.
You can use it at any time by clicking on the Auto button in the main
FlexColor window.
The Auto after new crop checkbox provides an optional shortcut for
using the auto function. When this checkbox is marked, each time
you make a new crop, FlexColor will immediately analyze the image
contained in the crop area and set highlight and shadow values, just as if
you had clicked on the Auto button.
You can also control this function by holding down the option key as you
deﬁne a new crop:
• If the Auto after new crop checkbox is enabled, then hold down the
option key to make a new crop without invoking the auto function.
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• If the Auto after new crop checkbox is disabled, then hold down the
option key to apply the auto function to your new crop.



This function will not update the highlight and shadow settings when
you move or resize an existing crop area; it only responds when you
create a new crop area. If you would like to use the auto function again
after moving or resizing a crop area, click on the Auto button in the main
FlexColor window.
For more information about tonal range and the Auto function, see “The
Histogram Window” on page 85 and “Auto Tab” on page 44. For more
information about cropping, see “The Main FlexColor Window” on
page 26.
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FlexColor ICC Proﬁles
Generic ICC Output Proﬁles
FlexColor includes six generic ICC output proﬁles for generating
various types of color separations. The name of each proﬁle provides a
description of the results it creates. See Table 1 for details.
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Table 1: Generic ICC output proﬁles included with FlexColor.
GCR stands for ‘Gray Component Replacement’. It is a scheme for adding
black to dark colors, thereby reducing the total amount of ink applied.
A high percentage of GCR results in more black ink in the image (and,
consequently, less ink of other colors).
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The skeleton black scheme does not add nearly as much black - especially
in the colors, thus resulting in brighter colors, but also requiring higher
quality paper. These proﬁles also specify the minimum ink percentage in
each channel that a color must have before any black is added at all.
If you are not sure which proﬁle to use, ask your printer if there is a
limit on the maximum ink percentage and be sure to choose a proﬁle
that limits the percentage appropriately. In the majority of cases, the
Hasselblad 330SKEL 30K75 proﬁle will provide the best results.
In some cases, a ICC proﬁle for your (or your service bureaus) speciﬁc
output device may be available. If so, then use it instead.
If your results are not satisfactory, then speak with your printer for
advice about how you should modify the proﬁle. See “Editing ColorSync
Color Proﬁles”

Editing ColorSync Color Proﬁles



The proﬁle editor is only available with the Mac OS version of FlexColor.
FlexColor includes both a ColorSync input proﬁle designed for the
Flextight scanner and a set of generic output proﬁles, each of which is
designed to create good results under a diﬀerent set of conditions.
These generic proﬁles will deliver adequate to excellent results. If, after
testing an output proﬁle and speaking with your service bureau, you
ﬁnd that you would like to ﬁne tune an output proﬁle, then follow the
procedure below.
The settings available for editing the output proﬁles are both highly
detailed and very powerful. In general, they are intended for users who
are very experienced in making color separations. Most likely, you should
speak with your service bureau about how to make these settings.
1. Run the FlexColor application.
2. Choose Setup from the File menu. Then click on the ColorSyncTM tab.
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3. Use the CMYK pop-up menu to select the proﬁle you would like to
edit. Note that the proﬁle you select must be as close as possible to
the proﬁle you want to make - you are not able to create a completely
diﬀerent proﬁle using the editor. The menu lists all of the proﬁles
currently installed in your System library Folder.
4. Click on the Edit button. The Output Proﬁle window appears.
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5. We recommend that you save your edited proﬁle using a new name, so
click on the Save as... button. The Create new Proﬁle window appears.
Type a name for your edited proﬁle and click on the Create button.

6. Return to the Output Proﬁle window. It shows the output values
applied in the ﬁnal separated ﬁle for each color at each of four
brightness (neutral-gray) levels (0%, 5%, 50%, and 100%). By
adjusting these levels, you are able to control how colors will appear
in your output. For example, if your prints look too yellow in the
highlights, then you could turn down the Y value for 0% and/or 5%
values. In many cases, this is all the level of detail you will need.
7. The Dot Gain Compensation setting compensates for the default
dot-gain setting of the existing proﬁle. The setting is relative, and can
be positive or negative. Generally, this value varies from printer to
printer. Finding the correct setting will require some trial and error.
8. If you need to make even more detailed adjustments, then click on the
triangle next to the Advanced heading.
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9. The Advanced section includes value settings for even more gray
levels. These settings include the same four levels that you were able to
adjust using the standard part of the Output Proﬁle window.
10. When you are done making settings in the window, click on the Save
button to apply the settings to your new proﬁle.
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The Thumbnails Window
Introduction
The Thumbnails window works like a light table, showing you a small
preview image of each of the scans made using the 3f button and stored
in the currently selected folder. Click the Folder button to select the
folder you want to use for your thumbnails. The name of the folder (ex.
My Pictures) appears in the title bar of the Thumbnails window. Use the
Thumbnails window to review your work, load images into the main
FlexColor window and to save images as standard TIFF ﬁles.

Opening the Thumbnails Window
To open the Thumbnails window, type cmd-8 or click on the
Thumbnails button in the main FlexColor window or select
Thumbnails from the Window menu.
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Files and Formats
When you scan using the Scan 3f button, the image is scanned and saved
as a 3f ﬁle in the currently selected folder and displayed in the preview
area of the main FlexColor window.
See “The 3f File Format” on page 10 earlier in this manual for a detailed
description. The Thumbnails window shows all of the 3f ﬁles saved in
the currently selected folder and allows you to load any of them in the
preview area of the main FlexColor window.

Saving Crop and Imaging Settings
If you make new settings with the various tools of FlexColor while a 3f
ﬁle is loaded into the main FlexColor window, your new settings will not
be saved unless you click on Save in the main FlexColor window. When
you do this, FlexColor will create a TIFF or JPEG ﬁle of the current image
in which all of the current crop, mode, color and image-enhancement
settings are applied. In addition, the settings will be saved as an entry in
the History list of the Info window for the current 3f ﬁle.
See “The Info Window” on page 79 for details. When you load a ﬁle from
the Thumbnails window into the main FlexColor window, all of the
crop, mode, color and image-enhancement settings currently selected as
default for the 3f ﬁle will also be loaded into FlexColor.

Using the Thumbnails Window
Viewing the Thumbnails Display
You have two types of options for controlling how the thumbnails will be
displayed in the Thumbnails window:
Sorting Use this pop-up menu to choose whether the thumbnails
should be sorted by Date (the order in which they were
created) or by Name. If you wish to reverse the sorting order
click the Descending/Ascending button to the right of the popup. Also it is possible to sort the thumbnails by their approval
status by checking the approval checkbox.
Size
Use this pop-up menu to choose how large you would like the
thumbnails to appear in the Thumbnails window.
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Crop mask button: Masks oﬀ the area outside the current
cropping (if any) for each image.
The Thumbnails window displays information about each 3f ﬁle:
Image currently
previewed

Selected thumbnail
(highlighted)

Crop mask

Approval mark

Image name

Selecting Images
You are able to select one or more images in the Thumbnails window.
Once you have selected an image, it will be shown highlighted. Then you
are able to, for example, rename, delete, view or save it. Use the following
techniques to select images:
• Click once on a thumbnail to select a single image.
• Cmd-click to select several images.
• Shift-click to select a consecutive row of images.
• Press cmd-a or choose Select All from the Edit menu to select all of the
thumbnails in the Thumbnails window.
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Working with Selected Images
The Thumbnails window includes the following controls, which operate
on the images you have highlighted:
Get Info Opens the Info window, which holds various information
about the image, such as size, resolution, frame size and
various information about copyright etc. (you can also choose
Get Info from the File menu or type cmd-i to open the Info
window). Note that an Info window will be displayed for each
of the selected ﬁles. See “The Info Window” on page 79 for a
detailed description.
Delete
Deletes the currently selected image(s). You will be asked to
conﬁrm the operation. The image(s) will be permanently
deleted from your hard disk too. Pressing the command (cmd)
key while clicking Delete will delete the selected image(s)
without conﬁrmation.
Note that you can delete the images using the del or cmd-del
keys on your keyboard as well.
Show
Displays the currently selected image in the main FlexColor
window, where you can view and work with it (this can also be
obtained by double-clicking on a thumbnail). The crop, mode,
color and image-enhancement settings selected as default for
the selected ﬁle will also be loaded into FlexColor. The button
is only available when you have selected a single image.
Please note that when double-clicking a thumbnail or clicking
the Show button, a low-resolution image will be displayed
immediately in the preview window, while the high resolution
preview is being processed in the background and when
ﬁnished the preview is updated (typically after 20-30 secs).
Save
This button saves all of the currently selected images. When
you click the button, the Batch Save window appears, asking
if you would like to save using the Individual settings &
cropping saved with each ﬁle, or to apply the Current settings
& cropping (as seen in the current preview of the main
FlexColor window) to all ﬁles.
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Choose either of the settings and then use the Mode pop-up
menu to select one of the following save options:
Normal: to save the selected images as TIFF-ﬁles.
Preview: to save the selected images as a low-resolution TIFFﬁle for preview purposes.
Layers: to save the selected images as separate layers in a
Photoshop ﬁle (.psd)
Having selected the appropriate save options, click the Save...
button.
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Modifying Selected Images
The Thumbnails window gives access to many diﬀerent types of
information about each image. It provides settings that enable you to
modify the images by adding new setups to the history, selecting a default
setup, entering meta data and more.

You can make these settings in two ways: using the Info window
or by using the Modify window, each of which is available from the
Thumbnails window. The two windows provide slightly diﬀerent
options; generally you will use the Info window to work with individual
images and the Modify window to modify several images at once, though
you might also sometimes use the Modify window for single images. The
Modify window and its settings are described in this section; for details
about the Info window, please see “The Info Window” on page 79.
Modifying the Setup and/or History
Each 3f ﬁle holds at least one setup, which is the setup used when the
ﬁle was ﬁrst scanned. Each time you export from a 3f ﬁle, the setup used
for the export is added to the history. When more than one setup exists
in the history, one of them is designated as the default setup, which is
applied to the thumbnail and is loaded when the ﬁle is opened in the
main FlexColor window.
You can use the Modify window to add a new setup, modify an existing
setup and/or make your new setup the default. To do this:
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1. stablish the setup you wish to use by doing one of the following:
• Load a target 3f image into the main FlexColor window and work
with the image size, position and correction controls until you
have the setup you need. This setup is known as the “current”
setup.
• Establish a current setup as described above and then save it as a
new stored setup (see “Managing Setups” on page 36 for details).
• Review your list of existing, saved setups and decide which of
these you wish to apply to your image.
2. Go to the Thumbnails (light table) window and select the image
or images you wish to modify. Note that the Modify window also
enables you to choose to apply your modiﬁcations to all images or to
all approved images, in which case it does not matter which images
you select now (see below).
3. Click on the Modify button in the Thumbnails window to open the
Modify window.

4. Set the Modify pop-up menu to match the scope in which you wish to
apply the modiﬁcation you are about to deﬁne. The following options
are available:
• Selection Only: applies your modiﬁcation settings only to the
images that were selected when you opened the Modify window.
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•

All: applies your modiﬁcations to all of the images currently open
in the Thumbnails window (i.e., to all 3f images in the current
folder).
• Approved: applies your modiﬁcation settings to all images
marked as approved, regardless of which images were selected
when you opened the Modify window.
5. Mark the top check box in the Modify window; this enables the
setup-modiﬁcation options.
6. If all of the setup-modiﬁcation settings are not visible, then click on
the triangle next to the check box to expose them.
7. Use the ﬁrst pop-up menu to control how the new setup should be
applied to each ﬁle in your scope. Choose one of the following:
• Add Setup: will add your new setup to the history, but will keep
the current default without changing it.
• Add Default Setup: will add your new setup to the history and
make this new history entry the default. The current default will
still be in the history and will remain otherwise unchanged.
• Update Default Setup: will completely replace the default setup
with the new setup. The old default will no longer be available in
the history.
8. Use the second pop-up menu to choose the setup to apply to each ﬁle
in your scope. Choose one of the following:
• Current: uses all of the settings applied to the preview image
currently displayed in the main FlexColor window.
• Standard: all of the standard setups included with FlexColor are
listed, grouped into negative and positive setups.
• User deﬁned: At the bottom of the menu is listed each custom
setup that you have saved.
9. If you also want to change the name and/or IPTC information for
your images, you can also do that now by checking the appropriate
boxes and making settings as described elsewhere in this section.
Clear one or both of these boxes to prevent these changes from being
made.
10. Click on Modify to apply your settings.
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Renaming Your Images
Each 3f ﬁle was given a name generated by the settings you made when
you scanned it. Sometimes, especially after a batch scan, you may want to
give a more descriptive name to each image.
You can use the Modify window to modify the name of one or more
images as follows:
1. Go to the Thumbnails (light table) window and select the image
or images you wish to modify. Note that the Modify window also
enables you to choose to apply your modiﬁcations to all images or to
all approved images, in which case it does not matter which images
you select now (see below).
2. Click on the Modify button in the Thumbnails window to open the
Modify window.
3. Set the Modify pop-up menu to match the scope in which you wish to
apply the modiﬁcation you are about to deﬁne. The following options
are available:
• Selection Only: applies your modiﬁcation settings only to the
images that were selected when you opened the Modify window.
• All: applies your modiﬁcations to all of the images currently open
in the Thumbnails window (i.e., to all 3f images in the current
folder).
• Approved: applies your modiﬁcation settings to all images
marked as approved, regardless of which images were selected
when you opened the Modify window.
4. Mark the Rename check box in the Modify window; this enables the
renaming options.
5. If the rename settings are not visible, then click on the triangle next to
the check box to expose them.
6. Make the following settings:
• Name: Enter a new root name here.
• Renumber from: If you have selected more than one image, then
each image will receive the root name you entered above, plus a
number which increments to ensure each image has a unique ﬁle
name. Enter the number for the ﬁrst image here.
7. If you also want to change the setup and/or IPTC information for
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your images, you can also do that now by checking the appropriate
boxes and making settings as described elsewhere in this section.
Clear one or both of these boxes to prevent these changes from being
made.
8. Click on Modify to apply your settings.
Neutralize and Unprocess
These two settings in the Modify window are only relevant for digital
camera images. They are inactive (grayed out) when you are working
with scanned images.
Changing Image Meta Data
Each 3f ﬁle is able to hold several ﬁelds of meta data (known also as
ITPC values), including a byline, copyright details and any number of
keywords. These make it easy to create a searchable database of images.
Some initial values are given when you ﬁrst scan the images, but often
you will want to update these to help uniquely identify each image.
You can use the Modify window the ITPC tags of one or more images as
follows:
1. Go to the Thumbnails (light table) window and select the image or
images you wish to modify. (Note that the Modify window will also
enable you to choose to apply your modiﬁcations to all images or to
all approved images, in which case it does not matter which images
you select now.)
2. Click on the Modify button in the Thumbnails window to open the
Modify window.
3. Set the Modify pop-up menu to match the scope in which you wish to
apply the modiﬁcation you are about to deﬁne. The following options
are available:
• Selection Only: applies your modiﬁcation settings only to the
images that were selected when you opened the Modify window.
• All: applies your modiﬁcations to all of the images currently open
in the Thumbnails window (i.e., to all 3f images in the current
folder).
• Approved: applies your modiﬁcation settings to all images
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4.
5.
6.

7.

8.

9.

marked as approved, regardless of which images were selected
when you opened the Modify window.
Mark the Change IPTC info check box in the Modify window; this
enables the IPTC options.
If the IPTC settings are not visible, then click on the triangle next to
the check box to expose them.
Make the following settings
• Byline: This ﬁeld often holds the name of the scanner operator
who made the original 3f ﬁle, but you might use it for any other
purpose. Enter a new value to update all ﬁles in your scope, or
leave the ﬁeld blank to leave current byline values in place.
• Copyright: This ﬁeld is intended to hold copyright details,
typically the photographer or bureau name plus a year. Enter a
new value to update all ﬁles in your scope, or leave the ﬁeld blank
to leave current values in place.
If you are building an image database, then keywords are very
important. When users search the database for images using a given
key word, all images that include that word in their keywords list will
be found. (The search may also return images that include the search
word in their ﬁle name and/or other IPTC ﬁelds.) Do the following to
establish the keywords list:
• Click on Add to add a new keyword. A small dialog window will
open in which you must type the word.
• To remove a word, select it from the Keywords list and click on
the Remove button.
• To keep all of the keywords already added to the ﬁles in your
scope, mark the Add to existing keywords check box. To remove
existing keywords and replace them with the new list you have
established, clear this check box.
If you also want to change the setup and/or names for your images,
you can also do that now by checking the appropriate boxes and
making settings as described elsewhere in this section. Clear one or
both of these boxes to prevent these changes from being made.
Click on Modify to apply your settings.
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Folder Selection and Favorites
The Thumbnails window displays a thumbnail image for each of the
3f ﬁles stored in a selected folder. You can use it to view any folder
available to your computer, including network shares. You do not need
to have scanned an image from your computer—or even have a scanner
attached—to view and edit images using the Thumbnails window.
The pop-up menu at the top left corner of the Thumbnails window
displays the name of the currently selected folder and provides entries
that enable you to select a diﬀerent folder using a ﬁle browser or
convenient lists of recent and favorite folders.

The following items are featured in the pop-up menu:
• Choose Location: select this entry to open a ﬁle-browser window,
which enables you to navigate to and select any folder visible from your
computer.
• Add to Favorites: adds the currently selected folder to the favorites
list at the bottom of the menu. This entry is not available if the current
folder is already a favorite.
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• Remove Favorite: removes the currently selected folder from the
favorites list at the bottom of the menu. This entry is not available
unless the current folder is already a favorite.
• Recent: this section of the menu lists the folders you have most recently
viewed using the Thumbnails window.
• Favorites: this section of the menu lists each of the folders you have
added as a favorite using the Add to Favorites entry described above.

Printing the Thumbnails
You can print the contents of the Thumbnails window:
• Make sure you have selected the view by clicking on a thumbnail in the
window.
• Select File -> Print.
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The Info Window
Introduction
The Info window holds various information about the currently
selected ﬁle and its contents, a complete history of applied settings and
the possibility to add unique ﬁle data (including IPTC-tags) such as
copyright information and keywords to support an image database.

Using the Info Window
Opening the Info Window
From the main FlexColor window, when an image is loaded, choose Get
Info from the File menu or type cmd-i to open the Info window:

From the Thumbnails window you can select one or more thumbnails
and use the Get Info button to display an Info window for each of the
selected ﬁles.
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The basic ﬁle information at the top of the Info window shows the name
of the 3f ﬁle, the date of creation and the ﬁle size. To change the ﬁle
name simply type a new name in the Name ﬁeld. The thumbnail image
displayed is created using the settings set as default in the History list.
General Info/History
The General Info section holds the following information:
Modiﬁed: Date of the latest modiﬁcation.
Frame:
Frame size of the original holder used when scanning the
ﬁle.
PPI:
Resolution of the ﬁle.
Device:
Hasselblad device used to scan the image.
Use the following ﬁelds to enter your own ﬁle information:
Byline:
Usually the name of the photographer. The contents, if any,
from the Byline ﬁeld in the Default Info section of the 3f
tab in the Preferences window (see page 53) will be added
automatically each time you scan using the Scan 3f function.
Copyright: Copyright information.
The contents, if any, from the Copyright ﬁeld in the Default
Info section of the 3f tab in the Preferences window (see
page 54) will be added automatically each time you scan
using the Scan 3f function.
Keywords: Add unique keywords about the image.
The keywords can be used to ﬁnd the image in an image
data-base.
Caption: Usually description of the image content.
To display the History list, select History from the pop-up menu.
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The history list includes an entry (with name, date, time and ﬁle size)
for each time new settings have been applied to the image and for each
TIFF ﬁle that has been created from it. The buttons below the list have the
following functions:
Show:
Select an entry and click the button (or double-click
the entry) to load the image into the FlexColor preview
window. The image will be loaded with the exact settings
used when the corresponding entry was generated. The
eye icon to the left of the entry indicates the ﬁle currently
loaded.
Delete... :
Deletes an entry.
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Make Default: Use button to select the entry with the settings that the
ﬁle should be opened, saved and exported with. The check
mark to the left indicates which entry is currently selected
as default. The settings of the entry selected as default
are also applied to the thumbnails displayed in the Info
window and in the Thumbnails window.
Add Current: Adds an entry to the list with the settings of the image
currently displayed in the FlexColor preview.
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The Color Info Window
Introduction
The Color Info window enables you to read pixel values at any point in
your image. You can also set up to ﬁve ﬁxed Sample points and read the
values at all of them simultaneously to monitor the eﬀects of your other
settings.
To open the Color Info window, type cmd-9 or click on the
Color Info button in the main FlexColor window or select
Color Info from the Windows menu.

Reading Values in the Color Info Window

To use the Color Info window, place the mouse cursor over the preview
image. The number ﬁelds in the window indicate the pixel brightness at
the selected position in the image. Note the following:
• When showing RGB, the values indicate pixel brightness values (0 255) with white = 255, 255, 255.
• When showing CMYK, the output values indicate ink percentage values
(0 - 100) with white = 0, 0, 0, 0. However, input values are still shown in
RGB, as described above.
The Sample pop-up menu indicates the size of the area sampled by the
color picker (mouse cursor). The numbers shown in the Color Info
window indicate averages of the values found in the sample area. You can
choose a setting of 1x1, 3x3 or 5x5 pixels.
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Setting Fixed Sample Points
You are able to set up to ﬁve ﬁxed Sample points so that you can monitor
the eﬀects that your settings are having in key areas around your image.
Each sample point is indicated with a diamond and a number in the
preview image. The current values for each sample point are shown next
to the appropriate number in the Color Info window.

To set a sample point, click on the Sample Point button, which
will turn grey when it is activated. Then click on a point in
your image to place the point. A numbered diamond will then
appear on the preview image at the point you select. You can
work with the sample points as follows:
• To move an existing sample point, activate the sample point picker by
clicking on the Sample Point button to make it grey, then click and
drag on the target point.
• To delete an existing sample point, activate the sample point picker,
click once on the target point and then press the backspace button on
your keyboard.
• To keep the existing sample points, but hide them in the preview,
mark the Hide points check box. To view and/or edit the points again,
remove the mark from this check box.
• To remove all sample points from your preview click Remove all.
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The Histogram Window
Introduction
The easiest way to set the highlight and shadow points is to use the Auto
tonal range button in the main FlexColor window. However, in some
cases, the auto function will not provide the desired results. The color
pickers and sliders in the Histogram window provide the tools you need
to ﬁne tune your highlight and shadow points.
• The highlight point is the brightness above which all input pixels will be
output at white (usually 255, unless you have set values in the Dot tab
sheet of the Setup window - see “Dot Tab” on page 45 for details).
• The shadow point is the brightness below which all input pixels will
be output at black (usually 0, unless you have set values in the Dot tab
sheet of the Setup window - see “Dot Tab” on page 45 for details).
You must take care when using these settings, as they can have a
powerful eﬀect on your images. Take some time to experiment with
them. Look at the preview to see how these settings will eﬀect the image.
Save some images after using these controls and inspect them closely.
Take notes on the kind of settings you use and make a comparative proof
print.
If you do not have any experience with digital images, then you should
speak with an experienced professional, such as a scanner operator
or digital photographer, about how these controls will aﬀect your
images. Ask him or her what to look for when you are evaluating
your proof prints. You should also read some books about digital
photography,digital imaging, scanning, and color reproduction.
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The Histogram Display
To open the Histogram window, type cmd-2 or click on
the Histogram button in the Correction area of the main
FlexColor window, or select Histogram from the Window
menu.
The Histogram window contains a graph that indicates the tonal range
of your image. The graph displays the number of pixels (on the vertical
axis) of each brightness (on the horizontal axis). Pixels with a value of 0
(black) are shown on the left; pixels with a value of 255 (white) are shown
on the right.
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Color Pickers
These enable you to click on pixels in your image to set highlight, shadow
and neutral points. See “The Histogram Color Pickers” on page 89 for
more information about using them.
Sliders
Click and drag the sliders to set the highlight and shadow points and
to set the minimum- and maximum output values. The min. and max.
output values reﬂect the settings on the Dot tab of the Setup window. See
“Dot Tab” on page 45 for details about these settings.



You can also use the arrow keys on the keyboard to move a slider once it
has been selected. Hold down the ctrl key to move in larger increments. Use
ctrl-tab to step between sliders.
Keep original cast in highlight: By default, the highlight
picker will set your selected point to pure white, thereby
modifying the color cast in the highlights of your image. Click
here to reset your highlight point to be the same in each color
channel, thereby keeping the original highlight cast.
Show output histograms: By default the Histogram window
shows the histogram captured by the scanner, with arrows
indicating where the highlight and shadow points cut in. In
the output, the brightness levels between these two points will
be spread to cover the full dynamic range (0 to 255). When this
is pressed (gray), the output histograms will be shown; when
not pressed (white), the input histogram and highlight/shadow
indicators are used.
Auto correction: Click here to apply the auto-correction
algorithm to your image. FlexColor will then analyze
your image and set recommended highlight, shadow and
neutralization points.
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Apply settings: When this is pressed (grey), then your
correction settings will be applied to the preview and ﬁnal
image. When not pressed (white), then the tool will hold your
settings, but they will not be applied to the image.
Reset/Preset: Click once here to reset the control to the
settings from your loaded setup or preset. Click and hold to
open a menu for selecting, saving and deleting presets. See
“Working with Presets” on page 97 for complete details about
how to work with this menu.

Hide/Show Color Channels
Click on this triangle to display separate histograms for each color
channel. You are able to adjust highlight and shadow values separately for
each.

89

The Histogram Color Pickers
The histogram color pickers enable you to point at any pixel in your
preview image and assign the highlight, neutralize, or shadow point
based on the value of that pixel. Both the highlight and shadow color
pickers will aﬀect the brightness and contrast in your image by choosing
the tonal range.
To use the color pickers:
1. Click on the appropriate eyedropper button for the type of tonal
range setting you would like to make. Your mouse pointer turns into
the selected eyedropper.
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2. Move the mouse pointer over the preview image; note pixel value
readings that appear in the Color area of the main FlexColor
window. Note that the numbers displayed in the Color area are the
current values (after histogram or gradation settings).

3. The Detail window can help you see individual pixels. To open
the Detail window, type cmd-5 or select Detail from the Window
menu (or click on the Detail button in the Zoom area of the main
FlexColor window).
To use the magniﬁer function of the Detail window push the
Magniﬁer button. Note that the pixel selector is outlined at the center
of the window.

4. Place the tip of the eyedropper over an appropriate pixel in the
preview image.
• When selecting a highlight point, select an object in the image that
you would like to have print white. Check the pixel values at several
potential white points to help you pick the best one (usually the
brightest one that is not already at the maximum of 255 in any of the
colors). All pixels brighter than the one you selected will burn out.
• When selecting a shadow point, select an object in the image that
you would like to have print black. Check the pixel values at several
potential black points to help you pick the best one (usually the
darkest one that is not already at the minimum of 0 in any of the
colors). All pixels darker than the one you selected will be black.
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•

When selecting a neutralize point, select an object in the image
that should be a neutral (gray) color. This will not aﬀect the image
brightness, only the color cast. For best results, select a point close to
the middle of the exposure range, for example with RGB pixel values
around 150.
5. Click on the target point. The highlight, shadow or gray value will be
reassigned to the values shown for that pixel in the info area. Your
screen will be instantly updated.
6. Inspect the preview using the Detail window and Color area. Look
for areas that are burned-out (showing values of 255) and also check
the shadow areas to be sure you have not hidden any details in these
areas. You can undo your settings by selecting Edit -> Undo or
pressing cmd-z on your keyboard.
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The Gradations Window
Introduction
The functions described in this section will not always be needed
during normal operation. They enable you to make ﬁne adjustments
to your output images that will aﬀect brightness and contrast and will
compensate for printing conditions. As with the advanced highlight and
shadow controls, take care when using the Gradations settings. Take
some time to experiment with its settings. Look at the preview to see how
the curve will eﬀect images. Save some images after using the settings
and inspect them closely. Take notes on the kind of settings you use and
make a comparative proof print.
To open the Gradations window, type cmd-2 or click on
the Gradation button in the Correction area of the main
FlexColor window, or select Gradations from the Windows
menu.

The Gradations window includes sliders for Contrast, Brightness,
Gamma and Shadow depth. It also includes a gradation curve, which is a
plot of input brightness (on the horizontal-axis) versus output brightness
(on the vertical-axis). You can hide or show the curve by clicking on the
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small triangle beneath the Shadow depth slider. All of the settings you
make using the curves and sliders in the Gradations window are saved
with the current setup. The contrast, brightness, gamma and shadow
depth settings can also be adjusted using the Contrast tab of the Setup
window.

Using the Sliders
The sliders provide a quick and easy way to adjust the contrast,
brightness, gamma, and/or shadow depth of your images. These
adjustments aﬀect the image, but are not reﬂected on the gradation graph
that appears at the bottom of the window if you click on the triangle.
The sliders behave as follows:
• Contrast: This control aﬀects the contrast in the image. Positive values
increase contrast in the overall image by compressing the contrast in
the highlight and shadow areas. Negative values reduce contrast in the
midtones, but improve visibility at the extremes of the tonal range. This
control is easy to use, but is less precise than using the curve.
• Brightness: This control aﬀects the brightness of all points in the
image. Positive values brighten the image, negative values darken it.
This control is easy to use, but is less precise than using the curve.
• Gamma: The gamma setting applies a predeﬁned gradation curve.
However, unlike the standard gradation curve, the gamma setting is
strictly controlled, so it enables you to use a color management program
that is calibrated to the scanner at a given gamma setting. The default is
2.0. If you raise the gamma setting, then the image will become lighter
and more details will be visible in the dark areas. The opposite occurs if
you decrease the setting.
• Shadow depth: This setting controls a complex algorithm that aﬀects
the level of detail visible in the shadow areas of your image. The higher
you move this slider, the more detail you will be able to see in the
shadows. However, this will also reduce contrasts in the rest of the
image. A setting of zero eﬀectively disables this feature.
For Apply setting or Reset/Preset see at page 88.



The sliders aﬀect all colors equally. They are not aﬀected by the setting in
the color channel pop-up menu located above the gradation curve.
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Using the Gradations Color Picker
The Gradations Color Picker in the lower left corner of the
Gradations window enables you to place a gravity point on the
curve at the brightness of a point that you select in the preview.
Click on the eyedropper icon to activate the gradations color
picker, then click on a point in the preview to place the gravity
point. See the next section for more information about using
the curve.

Using the Curve
The gradation curve is a plot of input brightness (on the horizontal-axis)
versus output brightness (on the vertical-axis). It provides extremely
detailed control over brightness and contrast in your ﬁnal image, and
even provides individual control over each color channel. You can hide
or show the curve by clicking on the small triangle beneath the Shadow
depth slider.
To adjust the curve, click and drag on the graph. Each time you click on
a new point, you will create a gravity point, which will pull the curve
toward itself. This system makes sure that the curve is always smooth.
The preview image will update to reﬂect your changes.
Here are some guidelines to help you make adjustments to the gradation
curve:

• To add a gravity point to the curve, click anywhere on the graph or use
the Gradations Color Picker, as described in the previous section.
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• To remove a gravity point from the curve, click on the point and then
press the backspace button on your keyboard.
• A neutral (default) gradation curve is a straight, diagonal line from the
lower left to the upper right of the graph.
• To add brightness to the image (without aﬀecting the highlight value),
drag the curve up above neutral. To darken an image, drag it below
neutral.
• To reduce the contrast in the shadow, midtone, or highlight make
the curve more ﬂat on the bottom-left, center, or top-right areas
respectively.
• To increase the contrast in the shadow, midtone, or highlight make
the curve more steep on the bottom-left, center, or top-right areas
respectively.
• To adjust the gradation in a single color channel, use the pop-up menu
located above the gradation curve. Options are: RGB, Red, Green,
Blue, Cyan, Magenta, or Yellow. This gives you a very powerful method
of adjusting color in your images.
• To adjust the gradation without changing the color balance, set the
pop-up menu above the gradation curve to RGB.
• All of the settings made to the gradation curve are saved with the setup,
just as all of the settings shown in the Setup window. See “Managing
Setups” on page 36 for instructions about how to select, load and save
setups.
• To neutralize all settings in all color channels of the gradation curve
and sliders, click on the Reset button. None of your other FlexColor
settings will be aﬀected.
Keyboard Shortcuts
While working with the gradation curve you have the following
possibilities:
• Pressing ctrl-tab to step between gravity points (when more than one
point is deﬁned)
• To move a gravity point, either drag it with your mouse or activate it
and then use the arrow buttons on your keyboard. Hold down the ctrl
key to move the point in larger increments.
• While dragging a gravity point using the mouse, hold down the shift
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key to restrict its movement to the horizontal direction.
• Clicking in the curve area while holding down the alt key changes the
numbers of grid lines.

Setting the Threshold for Lineart Scans
When you are scanning in Lineart mode, FlexColor applies a threshold
to create an image in which every pixel is either completely black or
completely white. In this case, the gradation curve is simply a vertical
line. You can move this line left or right to adjust the input level at which
the threshold is applied.

More
pixels
go to
white


More
pixels
go to
black

Click and drag on the line to adjust the threshold level to the right (which
will cause more pixels to go to black) or the left (which will cause more
pixels to go to white).

Working with Presets
The Gradation Window, and many of the other image-correction
windows, includes a preset/reset button, which enables you to save your
favorite settings, load them and/or to reset the tool to the selected preset
or setup.
In all image correction windows, the preset/reset button looks
the same. Click on the button just once to return to your
saved preset or setup. Click and hold to open a pop-up menu
for selecting preset option (see below). Initially, the loaded
preset will be the one from the setup you chose for the scan.
However, if you have chosen another preset, then a click on the
preset/reset button will return to the saved preset settings.
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The pop-up menu is divided into up to four sections, giving you the
following options:
• Create Preset: Saves your current tool settings. A window will open in
which you can name the new preset.
• Delete: if you have currently loaded one of your own custom presets,
then this entry is available. Select it to delete the current preset (shown
with a check mark in the menu).
• Current setup setting: the second section down from the top shows the
name of the current setup. Select this entry to revert to the setup.
• Factory presets: the third section down from the top shows the name of
the factory presets available for the current control (if any). Usually, this
includes an entry called “Default”, which resets the control to have a
neutral eﬀect. Select one of these entries to use a factory preset. Factory
presets cannot be deleted
• Custom presets: the last section in the menu lists the presets you have
saved for the current tool (if any). Select one of these entries to load
your custom preset.
The currently loaded preset shows a check mark in this menu. If you click
once on the preset/reset button, this selection will be reloaded from disk.
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Selective Color Correction
Introduction
Sometimes you need more control over the image colors than simply
removing a color cast. FlexColor features a powerful selective color
correction feature, which enables you to adjust the appearance of speciﬁc
colors throughout your image.

Opening the Color Correction Window
To open the Color Correction window, type cmd-3 or click
on the Color Correction button in the Correction area of the
main FlexColor window, or select Color Correction from the
Window menu.

Using the Color Correction Window
To use the Selective Color Correction:
1. Open the Color Correction window by selecting Color Correction
from the Window menu, or clicking on the Color Correction button
in the main FlexColor window.
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2. Click on the upper square area to the right in the Color Correction
window to activate the color correction color picker.
3. Click on the color in the preview image that you would like to change.
The color will immediately appear in the top (before) color box.
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Oﬀsets to its pixel values are listed in the R, G, B, C, M, and Y ﬁelds
(by default, these values are all set to zero).
4. The pop-up menu near the top of the window displays the nearest
primary color to the one you picked in the preview. Adjusting this
color will have the most dramatic eﬀect on the color you chose.
However, if you wish to edit a diﬀerent primary color, then select a
diﬀerent color from the pop-up menu.
5. Add or subtract any of the other colors using the arrow buttons and
numerical entry ﬁelds provided for each color channel. Positive
values will add the respective color, negative values will remove it. All
pixels containing the color selected in pop-up menu will be adjusted
proportionately.
6 If you would like to change the saturation throughout the image, then
use the Saturation slider. The hues will remain the same, but all of the
colors will become either more or less strong, depending on whether
you choose a positive or negative setting, respectively.
7. The lower square updates to show the eﬀects your changes will have
on the color you selected in the preview. Continue to adjust the
settings until you are satisﬁed with the color shown in this box.
Note also the Apply checkbox. When this box is checked, the color
correction will be applied to your preview and saved image. Remove the
check to disable color correction without erasing your settings. Click on
the box to toggle the check.
The Reset button returns all color correction setting to neutral. It does
not aﬀect any of your other FlexColor settings.
You can also view and edit settings made in the Color Correction
window by looking at the CC tab in the Setup window. The color
correction settings are saved and loaded together with all of the other
settings in the Setup window, so you can keep a library of your favorite
settings by saving a new Setup ﬁle for each one. See “Managing Setups”
on page 36 for more information.



If you are using the Gradations window to lighten the image, then you
may notice that the saturation decreases. To compensate, you may then
increase the saturation in the Color Correction window, which will make
the image look a bit darker again. Avoid entering a cycle in which you
repeat each of these settings until both windows are set to extremes.
Extreme settings will typically degrade your image.
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The Texture Window
Introduction
The Texture window holds both the Unsharp Mask ﬁlter and the
FlexTouch ﬁlter.
Unsharp Mask Filter
The Unsharp Mask ﬁlter applies an algorithm that increases contrast
along sharply deﬁned edges. Unsharp masking has the potential to both
improve and degrade your image - it makes the features more sharp, but
can also bring out noise or graininess. Most typically, noise will appear
ﬁrst in the dark areas of the image.
Color Noise Filter Settings
The color noise ﬁlter operates on the color information in your image
to remove electronic and/or ﬁlm-grain “noise” from the colors. In some
images, you might notice this noise manifest itself as graininess in the
darkest and most saturated colors.
FlexTouch Filter
This ﬁlter can be used for eliminating dust & scratches from the image.
Please note that the primary working area of the ﬁlter is the ﬁne dust
& scrathes, which are only recognizeable in 100% view. Very obvious
scratches and large pieces of dust or hair will not be removed - a manual
retouch will still be necessary in these cases.
Preview
Preview your settings using the Detail window. When using the
Unsharp Mask ﬁlter it is recommended to use at least two detail previews
so that you can compare the sharpening eﬀect in two diﬀerent areas
of your image - use one to check for enough sharpness in the bright or
midtone areas and another to check for noise resulting from too much
sharpness in the shadow areas. See “The Detail Window” on page 107 for
information about how to use the Detail window.
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Using the Texture Window
To open the Texture window, type cmd-4 or click on the
Texture button in the Correction area of the main FlexColor
window, or select Texture from the Window menu.

To access either of the ﬁlter’s setting parameters, click the appropriate
triangle to the left.
Unsharp Mask Filter

To change the ﬁlter’s settings, click in the appropriate ﬁeld and edit the
value with your keyboard or use the up- and down arrow buttons. The
controls have the following eﬀects:
• Apply checkbox: Turns the unsharp masking ﬁlter on or oﬀ. When the
box is checked, the ﬁlter will be applied to your ﬁnal image and to the
preview image (and detail images in the Detail window). To disable the
ﬁlter, remove the check. Click on the box to toggle the check.
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• Amount: Controls the strength of the sharpening eﬀect. The higher
the value, the stronger the sharp lines will become. Depending on your
image, a value between 80 and 200 is recommended.
• Dark limit: Sets the brightness level below which the ﬁlter has no eﬀect.
This will keep the ﬁlter from enhancing noise or unwanted textures in
your image. The higher this number, the less extensive the sharpening
eﬀect will appear. Depending on your image, a setting between 0 and 20
is recommended.
• Grain limit: Prevents the ﬁlter from sharpening low-contrast features
in the image, such as noise, or textures. It works by comparing
brightness of each pixel to the brightnesses of its surrounding pixels. If
brightnesses diﬀer by less than the Grain limit, then no sharpening is
applied to the target pixel. If your image looks grainy after sharpening,
try to increase the Grain limit setting.
• Radius: Sets the radius in which the unsharp masking algorithm
looks for sharp edges. The larger the radius, the more extensive the
sharpening eﬀect will be. The setting you choose will depend on the
contents of your image and the resolution you are using. Generally,
use a large radius with high-resolution images. Use a smaller radius for
lower resolutions images.
It is also possible to apply diﬀerent amounts of sharpening to each color
channel. This is controlled on the USM tab of the Setup window. See
“USM (Unsharp Masking) Tab” on page 42 for instructions.
Color Noise Filter Settings
The ﬁlter works by ﬁrst converting the image into the LAB color space (in
which brightness information is separated from color information) and
then removing graininess from the color channels. After processing, the
ﬁlter transforms the image back into standard RGB data. This process
essentially blurs information in the color channels, but because most of
the sharpness information is stored in the brightness channel, the overall
sharpness of your image will be aﬀected much less than the color noise.
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To apply the ﬁlter, open the Texture window and set the Color Noise
Filter ﬁeld to a value between 0 and 50. A setting of 0 eﬀectively disables
the ﬁlter; a setting of 50 gives the maximum eﬀect. The best setting to use
varies by image, so you must experiment to ﬁnd the optimal setting.
FlexTouch Filter

• Level: Controls the strength of the ﬁltering eﬀect. The best way to adjust
the level is to make detail views of a section in the image with dust and
a section with ﬁne details. Then turn up the level until you see an eﬀect
in the actual image details - then turn it down a few steps.

As with other image-correction setting, you have the following
additional controls for managing your color noise ﬁlter settings:
Apply ﬁlter: When this is pressed (grey), then the ﬁlter will
be applied to the preview and ﬁnal image. When not pressed
(white), then the tool will hold your ﬁlter setting, but it will not
be applied to the image.
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Reset/Preset: Click once here to reset the control to the
settings from your loaded setup or preset. Click and hold to
open a menu for selecting, saving and deleting presets. See
“Working with Presets” on page 97 for complete details about
how to work with this menu.
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The Detail Window
Introduction
The Detail window can show up to 4 detail views of the preview image
(in 100 to 400%).

The detail views are especially useful when you want to see the eﬀect of
the corrections performed using the various correction tools in diﬀerent
areas of your preview image.
The view to the left can be used either as a detail view or as a
magniﬁcation view enabling you to read color values for a speciﬁc pixel
in your image.
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Using the Detail Window
To open the Detail window, type cmd-5 or click on the Detail
button in the Zoom area of the main FlexColor window or
select Detail from the Window menu.
Delete detail view
Add detail view
Zoom Out
Zoom In

Currently
selected
detail view

Detail view

Magniﬁcation or detail view
Magniﬁcation button

Detail view lock

Use the “-” and “+” buttons to add or delete a detail view (views are
deleted from right to left) and select zoom level using the Zoom In and
Zoom Out buttons.
To create a detail view, click inside the view frame to activate it, then
move the cursor over the preview image - note that while you move the
cursor over the preview image, the detail view will show a low-resolution
view of the area around the cursor. Once you have located the spot in
the preview image from where you want the detail, click it once and the
detail image will be created in your currently selected detail view. To
make comparison between diﬀerent settings, you can lock individual
views by clicking the Detail View Lock icon which will prevent the view
from being updated when settings are changed.
To use the left view as a magniﬁcation view click the Magniﬁcation
button below the view. The magniﬁed image shown is the area
surrounding the mouse pointer. The selected pixel is the one directly
under the cross-cursor in the center of the magniﬁcation view.
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Batch Scanning
Introduction
The Batch Scan function enables FlexColor to:
• Create several diﬀerent scans of one or more originals contained in
a single original holder. Each scan in the batch can have completely
diﬀerent settings for all FlexColor windows, including resolution, crop,
color space, sharpening, tonal range, color correction, gradation, and all
setup tabs.
• Make 3f ﬁles in one working session from up to 10 diﬀerent originals,
each contained in diﬀerent original holders in the optional Feeder unit.



The Batch Scan function is especially useful when scanning several images
from a Feeder.
If you want to create several diﬀerent images from one or more originals
contained in one original holder, it is recommended to use the 3f Scan
function from the main FlexColor window to make 3f ﬁles from which you
can save an unlimited number of ﬁles with individual crops and settings.
To open the Batch Scan window, type cmd-6 or click on
the Batch Scan button near the top of the main FlexColor
window, or select Batch Scan from the Window menu.

Setting up a Batch Scan
Several Scans from the same Frame
1. Make a preview scan of your original.
2. Click on the Batch Scan button at the top of the main FlexColor
window or select Batch Scan from the Windows menu. The Batch
Scan window appears.
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To access the Manual parameters, click the triangle to the left.

3. Deﬁne a crop area and make scan settings in the Size area of the main
FlexColor window and in all Setup and Correction windows.
4. Click on the Add button in the Batch Scan window. A standard ﬁle
save window will appear. Use the window to choose a folder and ﬁle
name with which to save the scan. The scan will not be taken yet, but
its name will be added to the list in the Batch Scan window.
5. Repeat steps 3 and 4 until you have deﬁned all of the scans you want
to make.
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6. If you want to change any of your previously deﬁned scans, click on
the scan name in the Batch Scan window and make changes in the
other FlexColor windows. Then return to the Batch Scan window
and click on the Update button to save your changes.
To remove a scan from the batch set, click on the scan name and then
click on Remove.
When the Preview box is checked, the preview updates each time,
which takes about a second - note that when this box is not checked,
the preview image in the main FlexColor window will not update
each time you click on a new scan in the Batch Scan window. This
enables you to work faster.
7. When you are ﬁnished deﬁning the scans, click on the Scan button.
FlexColor scans and saves all of the scans you have deﬁned.
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Getting Information about Each Scan
You can get information about any scan listed in the Batch Scan window,
by double-clicking on an entry in the Batch Scan list. This will open a
Batch Scan Info window for the selected entry.

The window shows the following information:
• Destination: Shows the name assigned to the selected scan.
• Specify button: Click here to change the Destination name and folder.
• Status: Shows the status of the scan. If you are having problems with
the batch scan, look here for help.
• Frame: Shows the original holder being used.
• Mode: Shows the color mode (e.g., CMYK or RGB) that the scan will be
saved in.
• PPI: Shows the output resolution of the scan.
• Est. time: Shows and estimate of how long the selected scan will take.
• Width, Height, and Zoom: These ﬁelds display the output size of the
ﬁnal scan and the zoom level compared to the original.
• Size: Shows the ﬁle size of the ﬁnal scan.
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Working with Batch Presets

If you want to save a batch preset, then click on the New button in the
Batch Scan window. The Create New Batch Preset window appears.

Type a name and then click on Create. The preset name then appears
in the pop-up menu in the Preset area. If you have several batch presets
saved, then you can use the pop-up menu to switch between them.
To rename a batch preset, select the preset in the pop-up menu, then click
on the Rename button. The Rename Batch Preset window appears. Type
a new name and then click on Rename.

To delete a batch preset, select the preset in the pop-up menu, then click
on the Delete button.
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Using FlexColor with a Feeder
Introduction
Some Flextight scanner models either include or can be ﬁtted with a
batch feeder, which enables you to set up a series of images and then scan
them all at once without needing to stand at the scanner and monitor
progress. As of this writing, the following batch-feeder options are
available:
• Flextight Batch Feeder: holds several standard, ﬂexible original holders
of nearly any transparency format. This is an optional add-on for
Flextight 848 and 949 scanners.
• Mounted Slide Feeder: holds up to 50 mounted slides. This is an
optional add-on for Flextight 949 scanners.
• Flextight RF: a scanner dedicated to scanning roll ﬁlms. Each exposure
on the roll is saved as a separate ﬁle.
Each of these batch-feeder options is speciﬁcally supported in FlexColor.

Feeder Mounting and Maintenance
For batch feeders that can be mounted and removed from your scanner,
use the Maintenance > Feeder menu command of FlexColor to mount
and maintain your feeder. This command opens the Feeder window.

The following controls are available here:
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• Drum position: use this pop-up menu to set the drum position.
Depending on your feeder, you might use this to load/unload the
original holder and to set the scanner for scanning.
• Feeder position: use this pop-up menu to adjust the position of the
feeder magazine. You might use this to reset the feeder or to prepare it
for moving or storage.
• Tray displacement: usually, you will not need this, but if your feeder
has trouble moving an original in or out of the scanner (e.g., because
the original was not mounted properly), then you can use this to step
the feeder up or down a few notches. This is completely reset the next
time the feeder moves to load a new original.
• Mount: all feeders require a special mounting procedure that is assisted
by software. Click here to prepare the scanner to accept the feeder and
then follow the instructions in your feeder manual and on your screen.
• Unmount: this command helps you to safely remove a feeder from your
scanner. Click here to prepare the scanner to release the feeder and then
follow the instructions in your feeder manual and on your screen. <-Expected feature...
For complete details about how to assemble, install and maintain your
speciﬁc feeder model, please see your feeder’s documentation.

Scanning with a Feeder
When you are using a batch feeder, you will usually use either the batchscan feature or the 3f workﬂow. When you use the Flextight RF scanner,
you must always scan to 3f. For complete details about each of these
methods, please see:
• “Working with 3f” on page 117 for details about the 3f workﬂow.
• “Batch Scanning” on page 109 for details about using the standard batch
scan to TIFF workﬂow.
If you are using your batch feeder to build an image library, then we
strongly recommend the 3f workﬂow because it allows for easy scanning
and maximum ﬂexibility. If you are scanning a relatively small batch for
an immediate one-oﬀ job, then you might choose to use either 3f or the
standard batch-to-TIFF function.
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Working with 3f
Introduction to the 3f Format and Workﬂow
Though most DTP applications and print devices work with 8-bit images,
Flextight scanners actually capture 16-bit images. When FlexColor saves
ﬁnal scans as 8-bit TIFF or JPEG ﬁles, it starts with the full 16-bit scans
to give the various correction controls (especially histogram, gradation
and color correction) room to work, thereby enabling it to save an
optimized 8-bit image.
The standard scanning workﬂow is to load an original, take a preview,
make size and optimization settings and then save as a standard 8-bit
TIFF or JPEG ﬁle. This is the best way to work when you are scanning
images for a speciﬁc, single purpose. However, this results a ﬁnal image
in which much of the original scan data has been discarded during
image optimization and sizing. This is not a problem for a single-purpose
image, but if you need to use the image again later for another purpose,
you might need to re-scan it in order to get acceptable quality for the new
application.
Hasselblad’s unique 3f image-ﬁle format gives you the opportunity
implementing a more ﬂexible and eﬃcient workﬂow in which your store
full resolution, 16-bit images in your library and then export from these
as needed for various types of jobs. Here, you do not need to worry about
making settings during the scan—you simply save all of the available
scan data with each ﬁle. Later, when you are ready to use the image for a
speciﬁc job, FlexColor enables you to open your 3f ﬁle, apply sizing and
processing settings and then export to a standard 8-bit TIFF or JPEG
ﬁle. Your original 3f images are not aﬀected by your export settings,
so you can return to them at any time, make new export settings and
generate ﬁnal images of maximum quality, just as if you had scanned and
optimized the original all over again.
In addition to the raw image data, the 3f format stores a record of each
export you have made, so you can re-export using previous settings at
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any time. It also holds many other types of meta data (such as name,
key words, copyright details, etc.), which make 3f images perfect for
indexing with a database to create a searchable image library. Because 3f
is essentially an enhanced TIFF format, any image database application
that can read TIFF ﬁles will also be able to index the meta data stored in
3f ﬁles.
The trade-oﬀ comes from the ﬁle size; 3f ﬁles use twice as much data
per pixel and are furthermore usually full-resolution scans. These ﬁles
can therefore be several times larger than ﬁles that were scanned, sized,
optimized and saved for a speciﬁc print job. The 3f workﬂow is therefore
most useful for bureaus and photography houses that are interested in
provided libraries of images for use in a variety of settings. A large datastorage capacity is required.
Though all Flextight users can scan to 3f, customers using a Flextight
scanner that features a batch feeder or roll-ﬁlm loader will beneﬁt
most from the 3f workﬂow because it enables the entire batch to be
scanned and saved without requiring operators to consider each image
individually. By storing your 3f ﬁles on a network share, FlexColor users
throughout your organization can load, optimize and export images
whenever needed, without requiring access to a physical scanner.

Scanning to 3f
1. Press the 3f button in the main FlexColor window.
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2. Set the Crop pop-up menu to one of the following:
• Auto Detection: FlexColor will attempt to crop the image as
tightly as possible to keep all unexposed pixels out of the scan.
• Current Crop: FlexColor will use the crop area currently deﬁned
for the preview in the main FlexColor window. If you are batch
scanning, then you should only choose this option if all of the
originals you are scanning have the same format (e.g., 35 mm).
• Full Size: FlexColor will capture the full size available with your
current original holder or feeder. This setting will give you the
fastest scan time because no extra processing is required during
the scans.
3. Set the Film Type pop-up menu to one of the following:
• Auto Detection: FlexColor will attempt to determine the ﬁlm
type by analyzing image colors during scanning. This is most
useful when you are scanning a batch of mixed originals.
• Positive: For positive color and black & white originals.
• Color Negative: For color negative originals.
• B/W Negative: For black & white negative originals.
4. Set the Setup menu(s) to match the setup(s) you wish to use for your
scan. If you have set the Film Type to Auto Detection, then two setup
menus are provided: one for positives and one for negatives. If you
have set the Film Type to one of the speciﬁc settings, then only one
setup pop-up menu is shown. The choices given in the Setup menu(s)
include the default and custom setups for each appropriate ﬁlm type.
5. Mark or clear the following checkboxes, according to your
preferences:
• Auto levels: FlexColor will set highlight and shadow points for
each individual scan according to its internal algorithm. These
will become part of the default setup for your 3f ﬁles, but your raw
data will not be aﬀected; you will be able to change them during
export at any time.
• Auto focus: FlexColor will refocus before each scan. Auto focus
can add a few seconds to your scan times, but we recommend
that you use it anyway. You must always use this when you are
scanning mounted slides because slide mountings can vary in
thickness. When scanning with Flextight original holders, you
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can work with this box cleared; the scanner will then use its
calibrated focus settings.
• Frame recognition: Most Flextight original holders include a bar
code that identiﬁes the original format used by the holder (6x6,
6x7, 24x36, etc.), though not all Flextight scanners are equipped
to read the code. If your scanner supports frame recognition, then
this check box is available—mark the box to have the scanner
read the code before each scan and then readjust itself as needed
for each new format. The setting is disabled when a scanner that
does not support frame recognition is attached to your computer.
When this box is cleared or disabled, the scanner will scan using
the frame format established by your selected setup regardless of
what the bar code says. If you are using a batch feeder to scan a set
of originals with varying formats, then you must make sure that
all of your original holders include a bar code and then scan with
this option enabled. Scanning will be slightly faster when you do
not use frame recognition because the scanner will not need to
stop to read the bar code before each scan.
6. The Destination settings control the folder in which your 3f ﬁles will
be saved.
• The Destination pop-up menu shows the name of the current
destination folder. To change this, click on the menu and choose
select destination; this opens a ﬁle-browser window that you can
use to navigate to and select a new destination folder.
• The Job setting only has an eﬀect when you are using the Flextight
RF Scanner or a scanner ﬁtted with the Mounted Slide Feeder (but
not the standard Batch Feeder). Each of these scanner systems is
normally used for batch scanning many images at once. Therefore,
each time you start a new 3f scan with one of these scanners,
FlexColor will create a new sub-folder under your selected
Destination folder. The new sub-folder is named with the text
you enter here in the Job ﬁeld, plus a unique integer (e.g., Job 001,
Job 002, Job 003, etc.). All scans from the batch are then saved in
the new sub-folder and the Thumbnails window is set to show
the contents of this new sub-folder. On your next 3f scan, another
new folder will be created and the Thumbnails window will be
set to show this new folder. For other scanner conﬁgurations,
no sub-folders will be created and the Thumbnails window will
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not update to match any changes you make to the Destination
setting above. If you change your scanner conﬁguration (e.g.,
by removing the Mounted Slide Feeder or attaching a diﬀerent
scanner), then your new scans will be saved in the last-used Job
sub-folder until you change the Destination setting.
7. Set IPTC Info settings to control the basic meta-data that will be
saved with each scan. This can, for example, identify the scanner
operator and copyright details for each image. If these settings are
hidden, then click on the triangle next to the IPTC Info heading to
expose them. Set the following:
• Byline: this can be set to any value, but is often used to identify
the scanner operator. By default, it shows the name of the
currently logged in user.
• Copyright: enter the copyright details. Usually, this includes the
name of the image owner (e.g., the photographer) and the date the
image was created.
8. If you are using a standard or mounted-slide feeder, then the
following options are also available (if they are hidden, then click on
the triangle next to the Feeder heading to expose them):
• From Position: enter the number of the ﬁrst slide you wish to
include in the batch.
• To Position: enter the number of the last slide you wish to include
in the batch.
• Home: click here to move the feeder magazine to its home
position, in which slide one is in the scan position; this is the
position in which the feeder should be stored or moved.
• Unload: click here to push the original holder out of the scanner
so that you can remove it (usually as the ﬁrst step when removing
the entire feeder assembly).
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9. If you are using a Flextight RF Scanner (for scanning roll ﬁlms), then
the following controls are also available (if they are hidden, then click
on the triangle next to the Rollﬁlm scanner heading to expose them):
Spool backwards: click here to spool the ﬁlm backwards. It
will continue to spool until you click on stop or click again.
Stop: stops the ﬁlm rolling.
Spool forward: click here to spool the ﬁlm forward. It will
continue to spool until you click on stop or click again.
Usually, you will only use these controls to spool the ﬁlm all the way
out of the scanner, in which case it is always best to spool forward
because the ﬁlm moves more freely in that direction.
10. When you have ﬁnished making all of the 3f settings described above,
as they apply to your scanner, then click on Scan to scan the speciﬁed
images to 3f ﬁles.

Working with 3f Images
When you are ready to use 3f images from your library in an actual job,
you must load the images into FlexColor, make size and optimization
settings appropriate for the job at hand, and then export the images to
8-bit TIFF or JPEG ﬁles.
Use the FlexColor Thumbnails window to open a folder of 3f images
and display them in its “virtual light table”. From here, you can: view
information about each image, including its export history; load images
into the main FlexColor window to make export settings and view their
eﬀects; mark images for approval; change the setup associated with one
or more shots; and more. Each time you export from a given 3f ﬁle, your
settings are added to the ﬁle’s history, but the original image data is left
unchanged. You can also work by adding new setups to the history of
each ﬁle without exporting and then batch process to create your TIFF
or JPEG ﬁles all at once while you work elsewhere. For complete details
about these settings, please see “The Thumbnails Window” on page 65.
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When you are ready to use a 3f image in an actual job, do the following:
1. Use the Thumbnails window to view the folder where your 3f image is
saved.
2. Double-click on the target image to open it in the main FlexColor
window. When you do this, the window title shows a thumbnail
and the name of the ﬁle you have open (when scanning, it just says
FlexColor).
3. Make correction settings (histogram, texture, gradation, etc.) just as
you would when working with a scan preview.
4. Make sure you have selected the correct output proﬁle to match the
way the image will be printed. This is done using the ColorSync or
ICM tab of the Setup window (see “The ColorSync or ICM Tab” on
page 47 for details).
5. Establish your crop and output size by doing the following:
• Set the PPI pop-up menu to the output resolution required for the
job (typically, 300 for print jobs, 72 for the web).
• Deﬁne your crop area.
• Set the Width and Height to match the dimensions at which you
will use the image for the current job.
Note that when you have done this, the Zoom value will be adjusted to
match your settings so far. When a 3f ﬁle is loaded, this indicates the
resizing that will be made from the full resolution ﬁle (when scanning,
on the other hand, this indicates the optical zoom within the scanner).
You will not be permitted to make settings that result in a zoom level
over 200%—such images would not be sharp enough for professional use.
6. Do one of the following:
• Click on Save to export the image and add the new setup to the 3f
ﬁle history.
• Go back to the Thumbnails window to add your new settings to
the 3f ﬁle history and make them the current default for the image
(see also “Modifying the Setup and/or History” on page 70). This
way, you can prepare several images and then batch process them
all at once later.
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Appendix
Keyboard Shortcuts
Main FlexColor Window
F9:
Makes a preview scan.
Cmd or:
Opens previous or next image respectively.
Space:
Press and hold to drag preview around.
Cmd-0:
Zoom to ﬁt the entire preview image in the window.
Cmd +:
Zoom in.
Cmd –:
Zoom out.
Alt-Cmd-0:
Zoom to 100%.

Thumbnails Window
Cmd-A:
Selects all of the icons in the window.
Cmd-click:
Selects several images.
Shift-click:
Selects a consecutive row of images.
Cmd-I:
Opens an Info window for the currently selected
image(s).
a:
Toggles the approval status of the selected image(s)
on/oﬀ. Approved pictures are marked by a checkmark
in the lower left corner.
del:
Deletes the currently selected image(s) from your hard
disk. You will be asked to conﬁrm the operation.
Cmd-del:
Deletes the currently selected image(s) from your hard
disk without conﬁrmation.
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Info Window
F10:

File Menu
Cmd-N:
Cmd-S:
Cmd-W:
Cmd-U:
Cmd-I:
Cmd-P:

Edit Menu
Cmd-Z:

Cmd-R:
Cmd-X:

Cmd-C:
Cmd-V:
Cmd-A:

Toggles between General and History.

Makes a preview scan.
Makes a ﬁnal scan.
Closes the currently selected window if possible.
Opens the Setup window.
Opens an Info window, which contains various
information about the currently selected image.
Enables you to print the contents of the Thumbnails
window. Make sure you have selected the view by
clicking on a thumbnail in the window.

Reverses your most-recent actions - for example,
a crop area modiﬁcation or a change in the Setup
window. You are able to step back through a long
series of actions.
Reapplies the last action that you cancelled using the
Cmd-Z command.
If you have selected some text in a text ﬁeld, then this
command removes the text and saves it on a systemwide virtual clipboard.
Saves the selected text on the clipboard without
removing it.
Places a copy of the text on the clipboard at the
insertion point.
Selects all of the text contained in the ﬁeld in which
the insertion point is standing.
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Window Menu
Cmd-1:
Cmd-2:
Cmd-3:
Cmd-4:
Cmd-5:
Cmd-6:
Cmd-8:
Cmd-9:

Opens/closes the Histogram window.
Opens/closes the Gradations window.
Opens/closes the Color Correction window.
Opens/closes the Texture window.
Opens/closes the Detail window.
Opens/closes the Batch Scan window.
Opens/closes the Thumbnails window.
Opens/closes the Color Info window.
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Preventive maintenance
All Flextight scanners should be serviced every 25,000 scans or every 12
months, whichever comes ﬁrst. If a Feeder is mounted, the recommended
number of scans is 15,000 provided that the feeder is mounted for all
scans. Please note that previews are also counted as scans.
Newer Flextight scanners have a counter installed so as the number of
scans can be monitored. Please refer to the manual to learn more about
monitoring the number of scans.
Failures or faults originating from lack of service and/or daily
maintenance are not covered by the factory warranty.
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